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Preface

Purpose
This guide provides you with the information that you need to install and configure 
Essbase Deployment Services and Essbase Spreadsheet Services for use with 
Essbase. This book explains Essbase Deployment Services features and options 
and contains the concepts, processes, and procedures that you need to use the 
software. 

Audience
This guide is for system administrators and software developers who are 
responsible for installing Essbase Deployment Services, configuring it, and 
building client programs for use with the product.

Document Structure
This document contains the following information: 

● Chapter 1, “Product Overview,” introduces Essbase Deployment Services 
features, the development platform, and computer resource allocation for the 
product.

● Chapter 2, “Installing Software on Windows Systems,” describes how to 
install Essbase Deployment Services on Windows systems.

● Chapter 3, “Installing Software on UNIX Systems,” describes how to install 
Essbase Deployment Services on UNIX systems.
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● Chapter 4, “Configuring Software Components,” describes how to configure 
and run Essbase Deployment Services servers. This chapter also describes 
how to configure Essbase servers to work with Essbase Deployment Services 
servers.

● Chapter 6, “Setting up the Sample Programs,” describes how to setup, 
compile, and run the sample client programs provided with Essbase 
Deployment Services.

● Chapter 5, “System Administration,” outlines how to perform administration 
and maintenance tasks for Essbase Deployment Services systems.

● Chapter 4, “Advanced Installation Topics,” lists locations of essential files 
and describes how to create pointer files, replicate users across a cluster of 
servers, and uninstall the product. 

● Glossary contains a list of key terms and their definitions.

● Index contains a list of Essbase Deployment Services terms and their page 
references.

Related Documentation
Hyperion provides the following documentation for this product:

● The online Essbase Deployment Services Console Help in the Essbase 
Deployment Services DOCS directory, for more information about using the 
Deployment Services Console to manage servers and domains.

● The online Essbase Deployment Services JAPI Reference in the Essbase 
Deployment Services DOCS directory, for more information about using the 
Essbase Deployment Services Java application programming interface 
(JAPI).

● The online Essbase.properties Reference in the Essbase Deployment Services 
DOCS directory, for more information about using the settings of the 
essbase.properties configuration file.

● The Essbase Analytic Services Database Administrator’s Guide, for more 
information about configuring and using Essbase OLAP servers.
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Online Help

➤ To access online help:

1. In the installation directory for Essbase Deployment Services, locate the 
viewDocs.cmd file in the bin subdirectory.

2. Run the viewDocs.cmd file to display the online help.

➤ To print an online help topic, display the topic and select File > Print. 

To enable viewing of online documentation from the Help menu of Essbase 
Deployment Services Console Console on UNIX Systems, see Chapter 3, 
“Installing Software on UNIX Systems”.

Online Guides
The online guides are electronic versions of the printed documentation.

➤ To display an online guide: 

1. In the installation directory for Essbase Deployment Services, locate the 
viewDocs.cmd file in the bin subdirectory.

2. Run the viewDocs.cmd file to display the online help.

Conventions
The following table shows the conventions used in this document:

Table i: Conventions Used in This Document 

Item Meaning

➤  Arrows indicate the beginning of a procedure consisting 
of sequential steps.

Brackets [] In examples, brackets indicate that the enclosed 
elements are optional.

Bold Bold text indicates words or characters that you type 
exactly as they appear on the page. Bold in procedural 
steps highlights major interface elements.
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CAPITAL LETTERS Capital letters denote commands and various IDs. 
(Example: CLEARBLOCK command)

Ctrl + 0 Keystroke combinations shown with the plus sign (+) 
indicate that you should press the first key and hold it 
while you press the next key. Do not type the plus sign.

Example text Courier font indicates that the example text is code or 
syntax.

Courier italics Courier italic text indicates a variable field in command 
syntax. Substitute a value in place of the variable shown 
in Courier italics.

Italics Italics in a product-related term in the body of a book 
indicates that the term is also included in the glossary of 
the book.

n, x Italic n stands for a variable number; italic x can stand 
for a variable number or an alphabet. These variables 
are sometimes found in formulas.

Ellipses (...) Ellipsis points indicate that text has been omitted from 
an example.

Mouse orientation This document provides examples and procedures using 
a right-handed mouse. If you use a left-handed mouse, 
adjust the procedures accordingly.

Menu options Options in menus are shown in the following format. 
Substitute the appropriate option names in the 
placeholders, as indicated.

Menu name > Menu command > Extended menu 
command 

For example: 1. Select File > Desktop > Accounts. 

Table i: Conventions Used in This Document (Continued)

Item Meaning
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Additional Support
In addition to providing the documentation and online help, Hyperion offers the 
following support for product information.

Education Services
Hyperion offers instructor-led training, custom training, and eTraining covering all 
Hyperion applications and technologies. Training is geared to administrators, end 
users, and information systems (IS) professionals. 

Consulting Services
Experienced Hyperion consultants and partners implement software solutions 
tailored to clients’ particular reporting, analysis, modeling, and planning 
requirements. Hyperion also offers specialized consulting packages, technical 
assessments, and integration solutions.

Technical Support
Hyperion provides enhanced electronic-based and telephone support to clients to 
resolve product issues quickly and accurately. This support is available for all 
Hyperion products at no additional cost to clients with current maintenance 
agreements.

Documentation Feedback
Hyperion strives to provide complete and accurate documentation. We value your 
opinions on this documentation and want to hear from you. Send us your 
comments by clicking the link for the Documentation Survey, which is located on 
the Information Map for your product.
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1

Chapter

1
Product Overview

This chapter provides an overview of the Essbase Deployment Services product, 
including major features, software components, development platform, and 
discusses the allocation of computer resources for a production system. Essbase 
Deployment Services is a highly flexible software product and development 
technology platform, and it is recommended that you review this chapter in full 
before starting to develop client programs and deploy the product.

This chapter contains the following topics:

● “About Essbase Deployment Services” on page 14

● “Understanding the Essbase Deployment Services Development Platform” on 
page 16

● “Allocating Computing Resources for Essbase Deployment Services” on 
page 21
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About Essbase Deployment Services
Essbase Deployment Services provides a highly scalable, available, and reliable 
platform for developing large-scale, Web-enabled Essbase applications. Essbase 
Deployment Services works with Essbase and large-scale Java™ programming 
technology to bring enterprise-level performance and reliability to Essbase 
applications. 

Figure 1: Essbase System Architecture Overview 

The Essbase Deployment Services platform supports large scale Essbase 
applications by providing the following capabilities:

● Essbase server clustering: Essbase Deployment Services enables you to 
group sets of Essbase servers running applications with identical databases 
and use them as a single resource in your client programs. Support for server 
clustering enables additional features such as request load balancing and 
failover support.

● Essbase server load balancing: Essbase Deployment Services servers can 
receive requests to a single Essbase application and distribute requests across 
a cluster of Essbase servers running copies of that application.
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● Essbase server failover support: Essbase Deployment Services detects 
Essbase service interruptions in a cluster and automatically reroutes requests 
to other available Essbase servers.

● Essbase server connection pooling: Essbase Deployment Services enables 
client requests to share connections, conserving software and network 
resources and improving performance.

For an overview of the Essbase Deployment Services technology platform, see 
“Understanding the Essbase Deployment Services Development Platform” on 
page 16.

Software Components

Essbase Deployment Services requires two software components: Deployment 
Services must be connected to Essbase and you must have Java API client 
programs to run against the Deployment Services server. The Java API is included 
with Essbase Deployment Services and Java API client programs can be 
developed with it. You must purchase Essbase separately and develop the client 
programs using the Java programming language and the Essbase Java API. The 
relationship between the various Essbase and Essbase Deployment Services 
components is shown in Figure 2. The communication between Essbase 
Deployment Services and the Essbase cube is through TCP/IP or HTTP. Optional 
protocols are described in this chapter.

Figure 2:  Essbase Deployment Services System
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The client program is a custom-developed Java program that uses the Essbase 
JAPI to request data from Essbase applications.

Essbase is a multidimensional database server for business analysis. Essbase 
Deployment Services is designed to provide the services of Essbase servers in a 
distributed, highly scalable way. 

Essbase Deployment Services acts as a broker for client program requests to 
Essbase servers. The Essbase Deployment Services product family has four major 
components:

● Essbase Deployment Services Server, which acts as a gateway for Essbase 
requests and provides user authentication, load balancing, failover support, 
event handling, and messaging services.

● Essbase Deployment Services Console, which is a program for 
administering Deployment Services servers, Essbase servers, user accounts, 
and security information.

● Essbase Deployment Services Command Shell, which is a command-line 
interface for administering Deployment Services domains, Essbase servers, 
user accounts, and security information. 

● Essbase Java API, which provides Java programming interfaces for 
developing custom, Web-enabled programs that use Essbase services.

These components work together with Essbase servers and Essbase Deployment 
Services client programs to provide the services of the Essbase Deployment 
Services product.

Understanding the Essbase Deployment 
Services Development Platform

Essbase Deployment Services supports three types of software technologies for 
Essbase JAPI client programs: Transfer Control Protocol/Internet Protocol 
(TCP/IP), Hypertext Transfer Protocol (HTTP), and Enterprise JavaBeans (EJB). 
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When you start developing client programs for Essbase Deployment Services, you 
must choose one of these technologies for your client programs. The client 
program technologies are shown in Figure 3. 

Figure 3: Client Program Technologies

Client programs for Essbase Deployment Services must be written in Java, either 
as a servlet, applet, stand-alone application, or Enterprise Java Bean (EJB). The 
type of Java program you develop depends on the development technology 
(TCP/IP, HTTP, or EJB) you use with Essbase Deployment Services.

The following sections provide a brief overview of each of these supported 
technologies, along with some of their advantages and disadvantages.

For information about how to configure Essbase Deployment Services using one 
of these technologies, see Chapter 4, “Configuring Software Components.”
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TCP/IP Client Programs
Client programs can use TCP/IP to communicate with Essbase Deployment 
Services. TCP/IP is a well known and widely supported communication protocol 
used for computer to computer communication over the Internet.

Essbase Deployment Services can be installed either as an executable or as a 
service on Windows. Refer to Chapter 2, “Installing Software on Windows 
Systems.”. 

Figure 4: Java Applet Client Program Using TCP/IP

Client programs that use TCP/IP are usually stand-alone Java programs. However, 
these client programs can also run as Java servlets. If the client program uses 
TCP/IP, Essbase Deployment Services must run as a stand-alone Java program 
listening to TCP/IP on a defined port.
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HTTP Client Programs
Client programs can use HTTP to communicate with Essbase Deployment 
Services. HTTP is a well known and widely supported communication protocol 
used by Web browsers and Web servers to communicate over the Internet.

Client programs that use HTTP are usually Java applets running in a Web browser, 
as shown in Figure 5. However, the client program can also run as a stand-alone 
Java program or servlet. If the client program uses HTTP, Essbase Deployment 
Services must run as a Java servlet in a Java application server. The Essbase 
Deployment Services product includes Apache Tomcat application server in the 
default installation. Other application servers must be purchased separately.

Figure 5: Java Applet Client Program Using HTTP

Implementations of Essbase Deployment Services client programs using HTTP 
technology have the advantage of using the lightest client programs. Using an 
HTTP configuration also enables client programs to use Secure Sockets Layer 
(SSL) communication protocols. Client programs using HTTP with Essbase 
Deployment Services tend to be slower because the HTTP protocol is not 
optimized for software to software communication.
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EJB Client Programs
Client programs can use EJB and Remote Method Invocation (RMI) to 
communicate with Essbase Deployment Services. The RMI protocol is 
specifically designed for Java-to-Java communications and is meant for use within 
the context of Java application servers.

If you use EJB technology, both the client program and Essbase Deployment 
Services must run as EJBs within a Java application server. The Essbase 
Deployment Services product does not include a Java application server—this 
software must be purchased separately.

Figure 6: Client Program Using EJB

Implementations of Essbase Deployment Services client programs using EJB 
technology have the advantage of running both the client and server software in a 
single Java application server context. The disadvantage to this type of 
implementation is that a service interruption in either the client or server 
component can stop the Essbase Deployment Services system. This problem can 
be addressed by clustering Java application servers; that is, running additional 
copies of the Essbase Deployment Services client and server on separate, 
connected Java application servers.
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Allocating Computing Resources for Essbase 
Deployment Services

In planning the deployment of Essbase Deployment Services as a production 
system, developers and system administrators must answer several questions to 
properly deploy the software on their computers and networks.

● What are the current computing resource requirements and user capacity of 
the Essbase application that will be served by Essbase Deployment Services?

● What is the projected number of concurrent users for the Essbase Deployment 
Services system?

● How much concurrent usage can the different components of the Essbase 
Deployment Services system effectively serve? 

● How much memory and processing power should be devoted to the Essbase 
Deployment Services servers, Deployment Services client programs, and 
Essbase servers?

● How much and what type of persistent storage will the Essbase applications 
and the Essbase Deployment Services servers require?

● Is there enough network bandwidth to handle communications between the 
different components of the new Essbase Deployment Services system?

Allocating resources for large-scale server applications is a challenging task. It is 
not possible to provide definitive answers to these questions because Essbase 
applications, Essbase Deployment Services servers, and client programs require 
different resources in every case. However, the following considerations and 
guidelines should help in planning allocation of computing resources to your 
Essbase Deployment Services system.

Analyzing Essbase Applications
Before beginning the process of allocating resources for an Essbase Deployment 
Services system, you must first analyze the Essbase application you plan to serve 
with Essbase Deployment Services. The information obtained from this analysis 
will aid you in allocating resources for the Essbase Deployment Services system.
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➤ To analyze the Essbase application, perform the following general steps:

1. Investigate the current system requirements for the Essbase application you 
will be serving through Essbase Deployment Services. Make note of the 
following items:

● Processor usage (how many and what type)

● Memory usage while under a sustained load

● Disk space usage

2. Investigate how many concurrent users the application can serve with 
acceptable performance.

The statistics gathered in steps 1 and 2 provide a baseline for scaling your 
application to many more users. Once you understand the resources required to 
serve your Essbase application to a certain number of users, you can use this 
combination of processing power, memory, and disk space as a computing 
resource unit from which to estimate the resources required to serve a larger set of 
users.

3. Assess whether the Essbase application is optimized for best performance.

Many factors can affect the performance of a Essbase application. Ensuring 
that the Essbase application is designed for best performance will improve the 
overall performance of the Essbase Deployment Services system. For 
information about optimizing the performance of Essbase applications, see the 
Essbase Analytic Services Database Administrator’s Guide.

In your performance analysis, pay particular attention to retrieval 
performance. Since Essbase Deployment Services supports primarily retrieval 
operations, performance for these tasks is critical.

4. Make changes to the Essbase application to improve performance.

5. Repeat steps 1 and 2 to reassess the system requirements and concurrent load 
capabilities of the Essbase application.
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Concurrent Usage Limits and Considerations
In planning to serve a large number of users, there are some concurrent usage 
limitations to take into consideration. Server software programs typically have 
limitations as to the actual number of concurrent users they can support. Knowing 
these general limitations will help you in planning the number of servers you will 
need to deploy.

CAUTION: The numbers provided in the following section are estimates of 
capacity and are provided for planning purposes only. These estimates do 
not constitute a guarantee of actual capacity, as these numbers vary 
depending on application size, application logic, and hardware limitations.

In planning capacity for large numbers of users, keep in mind that the total user 
community will typically not use the system at the same time. The standard 
estimate for the percentage of a total user community that will actually be logged 
on and using a large-scale system at any one time is 20%. Thus, to serve a total user 
community of 10,000 users, plan to provide capacity to serve at least 2,000 
concurrent users.

A single Java 2, Enterprise Edition (J2EE)-compliant application server can 
typically handle up to 4000 concurrent users. Concurrent user limitations vary 
depending on the application server vendor. See the documentation for your 
application server for more information.

A single Essbase Analytic server can typically handle between 250 and 500 
concurrent users. Concurrent user limitations for Essbase depend on the size of the 
Essbase application and hardware limitations.

A single Essbase Deployment Services server can typically handle up to 2000 
concurrent users. Concurrent user limitations for Essbase Deployment Services 
depend on the size and complexity of the client program logic and hardware 
limitations.
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Allocating Processing and Memory Resources
In an Essbase Deployment Services system, the Essbase OLAP Server consumes 
the largest chunk of processing power and memory. Start your estimates with the 
resource requirements for your Essbase application as a stand-alone system.

CAUTION: The guidelines provided in the following section are estimates 
and are provided for planning purposes only. Actual requirements will vary 
depending on application size, application logic, and hardware limitations. 

To get a rough idea of the amount of processing and memory your Essbase 
Deployment Services system needs, take the number of concurrent users you need 
to serve with the system and divide it by the number of concurrent users that the 
computer running your Essbase application can effectively handle. This result tells 
you roughly how many computers with your current configuration you need to 
serve your user community.

Tip: If you are unsure of the number of concurrent users your Essbase application can 
handle, assume a maximum of 500 concurrent users

Estimating the computing resources necessary for Essbase Deployment Services 
servers and your client programs is challenging, because it depends on the 
software technology you choose, the size of your client program code and the 
complexity of its logic. However, as a starting point, assume that Essbase 
Deployment Services servers requires about one quarter to one third the processing 
power and memory that your Essbase servers need. For Essbase Deployment 
Services client programs that use a server component to feed requests to Essbase 
Deployment Services servers, assume these servers will need processing and 
memory resources at least equal to that of your Essbase Deployment Services 
servers.
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Persistent Storage Considerations
Persistent storage and retrieval of data on hard disks are typically the slowest parts 
of a software system. Software processes that require access to data on hard disks 
typically have the most impact on software performance.

In an Essbase Deployment Services system, the majority of performance impact 
from hard disk access comes from retrieval of data from Essbase databases. The 
Essbase Deployment Services server also requires hard disk access for retrieving 
user authentication and server cluster information, but this impact is not as 
significant on system performance.

To minimize the impact of hard disk access on an Essbase Deployment Services 
system, it is recommended that you store the database files for the Essbase 
applications in a high-speed RAID (Redundant Array of Independent Disks) 
system. This strategy minimizes the performance impact of hard disk access and 
increases the reliability of the Essbase Deployment Services system.

Assessing Network Bandwidth Requirements
Communications between large-scale server applications are taxing on network 
bandwidth. At the minimum, you should ensure that the computers that make up 
your Essbase Deployment Services system, including the Deployment Services 
servers, Essbase servers, and servers running the Essbase Deployment Services 
client programs have at least 100 megabit connections between each other. Higher 
bandwidth connections and dedicated network connections between the computers 
in your Essbase Deployment Services system are preferable. In general, the more 
concurrent usage of the system (the more users on the system at once), the more 
network bandwidth is required.
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2

Chapter

2
Installing Software on 
Windows Systems

This chapter describes the installation procedures for Essbase Deployment 
Services software (Server, Console, Command Shell, Essbase JAPI, batch files, 
data files, and sample programs) on Windows systems.

This chapter contains the following topics:

● “Windows System Requirements” on page 28

● “Installing Essbase Deployment Services on Windows Systems” on page 28

● “Installing Essbase Deployment Services as a Service on Windows 2000” on 
page 33

To complete the installation and run Essbase Deployment Services after running 
the installation program, see Chapter 4, “Configuring Software Components.”

For information about setting up the sample applications for use with Essbase 
Deployment Services, see Chapter 6, “Setting up the Sample Programs.”
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Windows System Requirements
Essbase Deployment Services for Windows needs a system that meets specific 
requirements. These requirements are described in Table 1.

Depending on the type of client programs you use with Essbase Deployment 
Services, additional system and software resources may be required. For more 
information on the types of client programs you can use with Essbase Deployment 
Services, see Chapter 1, “Product Overview” and Chapter 4, “Configuring 
Software Components.”

Installing Essbase Deployment Services on 
Windows Systems

The Essbase Deployment Services installation program installs Deployment 
Services files and common components that are used by various Hyperion 
products. The installation program does the following:

● Copies Essbase Deployment Services files to 
the\HYPERION_HOME\eds\7.1.0.0\ directory (or to the directory you 
specify) on your hard disk

Table 1: Essbase Deployment Services Server Windows System Requirements

Component Requirements

Microprocessor Pentium or higher

RAM 128 MB

Windows version Windows 2000 SP3 or Windows 2003

Disk space 148 MB:

• 85 MB for the server software, API, sample 
applications, and documentation

• 22 MB for the Essbase libraries

• 40 MB for the Java Runtime Environment

Essbase Release 7.0 or later

Java™ platform Java Runtime Environment version 1.4.1
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● Installs, if you choose, the Java Runtime Environment to the 
\HYPERION_HOME\common\jre directory

● Copies the Essbase Deployment Services sample application files to 
the\HYPERION_HOME\eds\samples directory on your hard disk

● Copies the Essbase Deployment Services documentation files to 
the\HYPERION_HOME\eds\docs directory on your hard disk

● Updates existing directories if you have a previous release of Essbase 
Deployment Services installed. 

● Creates the initial default user account with name=system and password=
password. This account is used to build additional user accounts. The 
password of the system account can be changed.

For more information about the directories created and files installed, see 
“Directories Created on Windows Systems” on page 31.

Installation Procedure for Windows Systems
Install Essbase Deployment Services server software on Windows platforms by 
running the self-extracting installation program that you downloaded from the 
Hyperion Web site.

➤ To install Essbase Deployment Services software to a computer running Windows:

1. Start the installation program by double-clicking on setup.exe. The 
InstallShield installation program displays the startup screen with a progress 
bar for loading the setup executable. 

2. The first dialog specifies the language to be used for the installation. Select a 
language and click OK to continue. 

3. The installation program displays an Essbase Deployment Services banner 
and launches the installation wizard. The first wizard screen displays some 
instructions for completing the installation process. Read the short list and 
click Next. 

4. The next dialog displays the location for the Hyperion Home Directory. The 
HYPERION_HOME directory contains the Deployment Services files and a 
directory containing components that are common to Hyperion products. 
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Those components include application servers, the Hyperion security platform 
components, the MySQL database, and the JDK Java Runtime Environment 
components. 

If this location is already in the environment variables of your system, then it 
can not be modified. If it is not already in your environment variables, 
customize the location of your HYPERION_HOME directory, then click Next. 

5. If a previous installation of Essbase Deployment Services is found, the 
installation program will give you a choice of whether to continue or cancel 
the new installation. You should uninstall previous versions before 
continuing. If you are going to install in a different directory you can continue. 

6. The next dialog displays the location for the Deployment Services files. The 
default location for the installed files is C:\Hyperion\eds\7.1.0 This is 
the recommended location for all the installed files. Click Next. 

7. The next dialog displays a choice of either the Typical or Custom installation. 
The Typical installation installs all Deployment Services files and is strongly 
recommended. A custom-designed installation is outside the scope of these 
steps. Click Next. 

8. The next dialog assigns ports for the default application server, Apache 
Tomcat. The assignments can be changed later. Deployment Services installs 
Jakarta Tomcat Application Server and by default configures Tomcat Default 
with port numbers 8080 for startup and 8005 for shutdown. Click Next. Make 
sure that subsequent installations of Apache Tomcat associated with other 
software (including Essbase Spreadsheet Services) use different port 
assignments. 

9. The next dialog assigns the port and location of the MySQL database. The port 
assignment can be changed later if needed. By default, Deployment Services 
installs MySQL as the domain storage database. The default path to the 
MySQL files (c:\Hyperion\common\DBMS\MySQL) is a directory of files 
that are commonly needed by Hyperion programs. A previous installation of 
Deployment Services or any of the other Hyperion products that use the 
common folder will have established the HYPERION_HOME\common path and 
the Deployment Services installation program will recognize that path. A 
first-time installation will not have that path set. By default, the port number 
for MySQL is 3306 and the database name is Essbase. It is recommended that 
you accept the default settings. Click Next. 
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10. The next dialog displays all the Deployment Services components that will be 
installed and their locations. Click Next to continue the installation. 

11. The installation program next displays a series of screens with a progress bar 
that indicates the percentage completion of the installation process. Wait until 
the process is complete and the final screen is displayed. Click Finish to end 
the installation. 

12. To start the server, go to Start > Programs > Hyperion Solutions > Essbase 
Deployment Services > Start Essbase Deployment Server - HTTP or Start 
> Programs > Hyperion Solutions > Essbase Deployment Services > Start 
Essbase Deployment Server - TCPIP

Directories Created on Windows Systems
If you chose to install the Essbase Deployment Services and Client, the installation 
program creates a directory structure including the following directories:

\HYPERION_HOME\eds\
     bin
     data
     deployments
     devtools
     docs
     essbase
     external
     lib
     redist
     samples
\HYPERION_HOME\common\
     appServers
     CSS
     DBMS
     JDK
     JRE
     XML
\HYPERION_HOME\uninstall

In addition to the Deployment Services components, the installation program 
installs several components in the \HYPERION_HOME\common directory and 
uninstaller programs in \HYPERION_HOME\uninstall. 

The devtools directory is not installed if you chose to install only the Essbase 
Deployment Client.
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The \eds directory contains the subdirectories where the files for Essbase 
Deployment Services are located. This directory is referred to in later chapters as 
the \HYPERION_HOME\eds\ directory. 

● The \bin directory contains the executable program files and server setting 
files for Essbase Deployment Services.

● The \data directory contains a database file which Essbase Deployment 
Services uses by default to store user names, server names, and other domain 
information.

● The \deployments directory contains application server files.

● The \devtools directory contains documentation for developers using the 
Essbase JAPI and Essbase Deployment Services.

● The \docs directory contains documentation for the Essbase Deployment 
Services, including the readme file and the Essbase Java API documentation.

● The \essbase directory contains a runtime version of Essbase.

● The \external directory contains library files from other vendors that 
support Essbase Deployment Services.

● The \lib directory contains library files for Essbase Deployment Services, 
including versions of the software that run as a Java servlet and an Enterprise 
Java Bean (EJB).

● The \redist directory contains the Deployment Services redeployment 
WAR files. 

● The \samples directory contains sample programs for use with Essbase 
Deployment Services. For more information about the sample programs, see 
Chapter 6, “Setting up the Sample Programs.”

● The \HYPERION_HOME\common\jre directory contains a copy of the Java 
Runtime Environment. This directory is present only if you chose to install 
Java during installation.

● The \HYPERION_HOME\uninstall directory contains information and 
executables for uninstalling Essbase Deployment Services.
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Installing Essbase Deployment Services as a 
Service on Windows 2000

Essbase Deployment Services can be installed to run as a service under Windows 
2000. As a service, Essbase Deployment Services uses the native TCP/IP 
communications protocols. 

The installation of Essbase Deployment Services as a service is slightly different 
than the standard installation under Windows 2000. After performing the standard 
installation on Windows 2000, complete the following steps to run Essbase 
Deployment Services as a Windows service. 

1. Add the following statements to the System path (this example assumes that 
you have installed Java at c:\jdk1.4.1 and installed Essbase Deployment 
Services at c:\eds): 

c:\jdk1.4.1\bin;c:\jdk1.4.1\jre\bin\server;c:\
HYPERION_HOME\eds\bin

2. Add the following statements to the Class path:

c:\jdk1.4.1\bin;c:\eds\lib\ess_es_server.jar;c:\
HYPERION_HOME\eds\lib\ess_japi.jar;

3. Add the following jar/zip files to the Class path if you are using RDBMS as 
your Domain Storage:

● For DB2: db2java.zip 

● For SQL: JSQLConnect.jar 

● For Oracle: classes12.zip 

● For MySQL: mysql-connector-java-3.0.8-stable-bin.jar 

4. In the Essbase.Properties file, specify the absolute paths to the following 
EDS components (by default they are specified by a relative path): 

● system.arborPath 

● system.dataDir 

● system.log.file.name (if you enable logging) 

● domain.store.file.name 
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5. The system variable ARBORPATH should point to the 
c:\HYPERION_HOME\eds\essbase\ directory and PATH should 
also point to ARBORPATH\bin. 

6. Leave the EDS executable, EssbaseEnterprise.exe, in the eds\bin 
folder. It is not necessary to put the EDS executable in a system directory as 
is often the case with Windows services.

7. Restart your machine to effect all the Path and Classpath settings.

8. Register the service: EssbaseEnterprise -i. 

You will get a message stating that “the Essbase Deployment Services are 
ready”. For future reference, the statement to unregister is similar 
(EssbaseEnterprise -u). Do not unregister at this time.

9. After registering the service, go to Start > Control Panel > Services > 
EssbaseDeploymentServices, to start the service. 

The Essbase Deployment Services are now available through the EDS console or 
through the client tools (startcmd.cmd, startgui.cmd, and startees.cmd). 
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3

Chapter

3
Installing Software on UNIX 
Systems

This chapter describes the installation procedures for Essbase Deployment 
Services software (Server, Console, Command Shell, Essbase JAPI, batch files, 
data files, and sample programs) on Solaris™.

This chapter contains the following topics:

● “Solaris System Requirements” on page 36

● “Installing Essbase Deployment Services on UNIX Systems” on page 37

● “Installing Essbase Deployment Services to Run as a Background Process” on 
page 41

To complete the installation and run Essbase Deployment Services after running 
the installation program, see Chapter 4, “Configuring Software Components.”

For information about setting up the sample applications for use with Essbase 
Deployment Services, see Chapter 6, “Setting up the Sample Programs.”



36 ■

Installing Software on UNIX Systems

Essbase Deployment Services Installation Guide

Solaris System Requirements
Essbase Deployment Services for UNIX requires a system that meets minimal 
hardware and software requirements. Essbase Deployment Services for Solaris 
requires a system with the following minimal hardware and software 
requirements:

Depending on the type of client programs you use with Essbase Deployment 
Services, additional system and software resources may be required. For more 
information on the types of client programs you can use with Essbase Deployment 
Services, see Chapter 1, “Product Overview” and Chapter 4, “Configuring 
Software Components.”

Table 2: Essbase Deployment Services Solaris System Requirements 

Component Requirements

Server platform Sun SPARC or ULTRASPARC machines

Solaris version 7 or 8

Physical memory 128 MB RAM

Disk space 148 MB:

• 85 MB for the server software, API, sample 
applications, and documentation

• 19 MB for the Essbase libraries

• 40 MB for the Java Runtime Environment

Essbase Release 7.0 or later

Java™ platform Java Runtime Environment version 1.4.1



Installing Essbase Deployment Services on UNIX Systems

3

■ 37Essbase Deployment Services Installation Guide

Installing Essbase Deployment Services on 
UNIX Systems

The Essbase Deployment Services installation program performs the following 
operations:

● Copies Essbase Deployment Services files to the /HYPERION_HOME/eds 
directory (or to the directory you specify) on your hard disk. 

● Installs, if you choose, the Java Runtime Environment to the 
/HYPERION_HOME/common/jre directory. 

● Copies the Essbase Deployment Services sample application files to 
the/HYPERION_HOME/eds/samples directory on your hard disk. 

● Copies the Essbase Deployment Services documentation files to 
the/HYPERION_HOME/eds/docs directory on your hard disk. 

● Creates the initial default user account with name=system and password=
password. This account is used to build additional user accounts. The 
password of the system account can be changed. 

● Updates existing directories if you have a previous release of Essbase 
Deployment Services installed. 

For more information about the directories created and files installed, see 
“Directories Created on UNIX Systems” on page 39.

Installation Procedure for UNIX Systems
Install Essbase Deployment Services server software on UNIX platforms by 
running the self-extracting installation program that you downloaded from the 
Hyperion Web site.

➤ To install Essbase Deployment Services software on a computer running a UNIX 
operating system:

1. Start the installation program by double-clicking on setup.bin. The 
installation program displays the startup screen with a progress bar for loading 
the setup executable. 

2. The first dialog specifies the language to be used for the installation. Select a 
language and Click OK to continue. 
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3. The installation program displays an Essbase Deployment Services banner 
and launches the installation wizard. The first wizard screen displays some 
instructions for completing the installation process. Read the short list and 
click Next. 

4. The next dialog displays the location for the Hyperion Home Directory. The 
HYPERION_HOME directory contains the Deployment Services files and a 
directory containing components that are common to Hyperion products. 
Those components include application servers, the Hyperion security platform 
components, the MySQL database, and the JDK Java Runtime Environment 
components. 

If this location is already in the environment variables of your system, then it 
can not be modified. If it is not already in your environment variables, 
customize the location of your HYPERION_HOME directory, then click Next. 

5. If a previous installation of Essbase Deployment Services is found, the 
installation program will give you a choice of whether to continue or cancel 
the new installation. You should uninstall previous versions before 
continuing. If you are going to install in a different directory you can continue. 

6. The next dialog displays the location for the Deployment Services files. The 
default location for the installed files is <user_home>/eds/7.1.0.0. To 
change the location, either browse to a directory or type in the path. Click 
Next. 

7. The next dialog displays a choice of either the Typical or Custom installation. 
The Typical installation installs all Deployment Services files and is strongly 
recommended. A custom-designed installation is outside the scope of these 
steps. Click Next. 

8. The next dialog assigns ports for the default application server, Apache 
Tomcat. The assignments can be changed later through the Tomcat user 
interface. Deployment Services installs Jakarta Tomcat Application Server 
and by default configures Tomcat with port numbers 8080 for startup and 8085 
for shutdown. Make sure that any other instances of Tomcat on this machine 
use different port assignments. If you have already installed Jakarta Apache 
Tomcat and know the port assignments are different from the defaults, type 
those port numbers in the text boxes. In other cases, leave the default port 
assignments and click Next.

9. The next dialog assigns the port and location of the MySQL database. The port 
assignment can be changed later if needed. By default, Deployment Services 
installs MySQL as the domain storage database. The default path to the 
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MySQL files (HYPERION_HOME/common) is a directory of files that are 
commonly needed by Hyperion programs. A previous installation of 
Deployment Services or any of the other Hyperion products that use the 
common folder will have established the HYPERION_HOME/common/ path and 
the Deployment Services installation program will recognize that path. A 
first-time installation will not have that path set. By default, the port number 
for MySQL is 3306 and the database name is Essbase. It is recommended that 
you accept the default settings. Click Next. 

10. The next dialog displays the all the Deployment Services components (and 
locations) that will be installed. Click Next to continue the installation. 

11. The installation program next displays a series of screens with a progress bar 
that indicates the percentage completion of the installation process. Wait until 
the process is complete and the final screen is displayed. Click Finish to end 
the installation. 

Note: The Essbase Deployment Services installer requires a system with the 
JAVA 1.4.1 Runtime environment installed. 

Directories Created on UNIX Systems
If you chose to install the Essbase Deployment Server and Client, the installation 
program creates a directory structure including the following directories:

/HYPERION_HOME/eds/
     bin
     data
     deployments
     devtools
     docs
     essbase
     external
     lib
     redist
     samples
/HYPERION_HOME/common/
     appServers
     CSS
     DBMS
     JDK
     JRE
     XML
/HYPERION_HOME/uninstall



40 ■

Installing Software on UNIX Systems

Essbase Deployment Services Installation Guide

In addition to the Deployment Services components, the installation program 
installs several components in the /HYPERION_HOME/common directory and 
uninstaller programs in /HYPERION_HOME/uninstall. 

The devtools directory is not installed if you chose to install only the Essbase 
Deployment Client.

The /eds directory contains the subdirectories where the files for Essbase 
Deployment Services are located. This directory is referred to in later chapters as 
the HYPERION_HOME/eds or the eds_home directory.

● The /bin directory contains the executable program files and server setting 
files for Essbase Deployment Services.

● The /data directory contains a database file which Essbase Deployment 
Services uses by default to store user names, server names, and other domain 
information.

● The /deployments directory contains application server instances.

● The /devtools directory contains documentation for developers using the 
Essbase JAPI and Essbase Deployment Services.

● The /docs directory contains documentation for the Essbase Deployment 
Services, including the readme file and the Essbase JAPI documentation.

● The /essbase directory contains a runtime version of Essbase.

● The /external directory contains library files from other vendors that 
support Essbase Deployment Services.

● The /lib directory contains library files for Essbase Deployment Services, 
including versions of the software that run as a Java servlet and an Enterprise 
Java Bean (EJB).

● The /redist directory contains the Deployment Services redeployment 
WAR files. 

● The /samples directory contains sample programs for use with Essbase 
Deployment Services. For more information about the sample programs, see 
Chapter 6, “Setting up the Sample Programs.”

● The /HYPERION_HOME/common/jre directory contains a copy of the Java 
Runtime Environment. 
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Installing Essbase Deployment Services to Run 
as a Background Process

To Start the EDS Server As Background Process on UNIX, you need to make a 
change to the StartEES command file.

In the startees file, edit the last line. Originally, the last line in the file is: 

java com.essbase.server.EssbaseEnterprise tcpip

Change that line as follows:

nohup java com.essbase.server.EssbaseEnterprise tcpip &

The change will take effect on the next restart of the machine.

Installing From the Command Line
To run the Deployment Services installation program from the UNIX command 
line in console mode, without graphical windowing software such as X-Windows, 
use the following command: 

> setup.bin -console

Uninstalling Previous Versions 
If you have an older version of Essbase Deployment Services installed, before you 
install a newer version, you must run the uninstall program. In addition to running 
the uninstall program, you need to delete the folder where the previous version of 
the product was installed. You must do this step because the uninstall program 
does not completely remove the configuration information from the previous 
version of Essbase Deployment Services.

Manually delete the essbase.properties, css.xml, domain.db, and 
console.log files. These files are not automatically removed by the uninstaller 
program. 

If these files are modified after installation either by the user or by Deployment 
Services, a new installation will prompt to overwrite them. If the earlier 
configuration needs to be preserved, manually save the essbase.properties, 
css.xml, and domain.db files to a safe location and replace them to their 
respective locations after the new installation is completed. 
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Specific UNIX Installation Settings
For AIX 5.1 and 5.2, apply the following patch: 

● PTF fix number U489780 

● Fileset xlC.aix50.rte.6.0.0.7 "C Set ++ Runtime for AIX 5.0" 

For AIX, EDS packages a JDK installed under the HYPERION_HOME 
environment variable. Depending on the installation, Deployment Services can 
have trouble recognizing the path to the JDK. Users should make sure that a valid 
JDK version 1.4.2 is installed in the target machine and that the batch files in the 
eds/bin folder point to this valid JDK. 

On UNIX platforms if the Deployment Server cannot connect to the 
MySQL domain store, the file mysql_start.sh located in 
$HYPERION_HOME/common/DBMS/MySQL/4.0.12/bin/ must be 
modified to refer to mysqld instead of mysqld_safe. The domain store 
database must be named “essbase” and is created by the command: 

>mysqladmin -uroot create essbase

Most UNIX platforms have a loopback “localhost” record in the /etc/hosts file, 
but the order may different. So, in order to make MySQL accept connection for 
user “root” from localhost, you need to modify /etc/hosts to make sure 
“localhost” immediately follows the first IP address. For example:

127.0.0.1    localhost    localhost.localdomain

Batch File Environment Variables

StartEDSTomcatServer.sh JAVA_HOME, PATH and LIBPATH

StopEDSTomcatServer.sh JAVA_HOME, PATH and LIBPATH

startees PATH and LIBPATH
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Viewing Online Documentation on UNIX 
Systems

On UNIX systems, you must modify the startgui file in order to launch the 
online documentation properly from the Help menu of Essbase Deployment 
Services Console.

Figure 7: Help Menu of Essbase Deployment Services Console

➤ To enable viewing of online documentation from the Help menu:

1. Edit startgui, located in the HYPERION_HOME/eds/bin directory.

2. Add the following CODEBASE parameter to the java.com statement in 
startgui:

java.com.hyperion.essbase.beans.main.EssGuiConsole 
CODEBASE=HYPERION_HOME/eds username=guest password=
password DOMAIN=essbase PREFSERVER=localhost ORBTYPE=
tcpip PORTNO=5001

where HYPERION_HOME/eds is the directory where you installed Essbase 
Deployment Services.

3. Save the startgui file.

Selecting Help Topics or Product Documentation from the Help menu of Essbase 
Deployment Services Console launches the documentation properly.
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Chapter

4
Advanced Installation Topics

This chapter describes advanced installation procedures for Essbase Deployment 
Services, provides a list of locations for commonly needed files, lists the 
commands for Essbase Deployment Services Command Shell, and provides 
instructions for uninstalling the product.

This chapter contains the following topics:

● “Migrating to New Releases” on page 45

● “Creating Pointer Files to Essbase.properties” on page 46

● “Command Shell Commands” on page 47

● “Uninstalling Essbase Deployment Services” on page 48

● “Configuring Essbase Deployment Services Servers” on page 50

● “Configuring Essbase Analytic Servers” on page 54

● “Defining Clusters and Connection Pools” on page 57

● “Deploying Deployment Services on Application Servers” on page 59

Migrating to New Releases
When migrating to a new release of Deployment Services, administrators should 
consider the following issues:

● Deployment Services keeps the domain information in two locations. The 
accounts, connection pool, cluster, and outline caching information is stored 
in domain.db. The table space based on the domain types referred in 
essbase.properties is stored in the file ess_sys_001. Save these files 
before installing the new release. These files should also be backed up during 
the routine maintenance of Deployment Services. 
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● Deployment Services provides the Hyperion security platform information in 
css.xml (<EDS_HOME>\data\css.xml). If you are using this 
configuration for your production setup, back up this file before installing the 
new release.

● Any other modified files can be saved based on the individual needs of 
customer. This includes essbase.properties, startees, startgui, and 
startcmd.

Creating Pointer Files to Essbase.properties
When you set up Essbase Deployment Services to run as servlet or EJB in a Java 
application server or Web server, you must provide the Deployment Services 
server with access to an essbase.properties file. The usual way to handle this 
requirement is to copy the essbase.properties file into a directory of the Java 
application server or Web server. However, you can avoid having duplicate copies 
of this file by creating essbase.properties files that act as pointers to a central 
essbase.properties file. By creating files that point to a central 
essbase.properties file, you can have a single essbase.properties file 
for all Essbase Deployment Services servers. This technique simplifies the 
administration of Essbase Deployment Services by minimizing the number of 
essbase.properties files you have to manage.

Note: A pointer file cannot point to another pointer file.

➤ To create a pointer file to another essbase.properties file:

1. In a text editor, start a new file called essbase.properties.

2. Type the following text into the file:

# pointer file to essbase.properties
system.props.file=
C:/HYPERION_HOME/eds/bin/essbase.properties 

The above example shows the default location for the essbase.properties 
file. Modify the path to this file to fit your computer environment.

3. Save the essbase.properties file in directory of the Java application 
server where you would normally put the full essbase.properties file. 

For more information on where this file should be located, see “Configuring 
Servers to Use TCP/IP, HTTP, or EJB” on page 52.
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Command Shell Commands
Essbase Deployment Services has a command line interface component called the 
Command Shell. When you start the Essbase Deployment Services server as a 
stand-alone application—using the startees.cmd file—the Command Shell is 
displayed. Use this console to perform high-level server operations. Pressing the 
Enter key in the server window displays the Command Shell prompt. Typing help 
and pressing Enter provides a list of all available commands.

You can start the Command Shell as a program separate from the Essbase 
Deployment Services server. For information about starting the Command Shell as 
a separate program, see “Starting and Stopping the Deployment Services 
Command Shell” on page 49.

You can use the following commands in the Command Shell:

Table 3: Command Shell Commands 

Commands Description

quit/exit Shuts down the Command Shell

If this command is issued from within the Essbase 
Deployment Services server window, the server is also shut 
down.

help Lists all Command Shell commands and their functions

runningeesservers Lists all the currently running Essbase Deployment Services 
servers

signon Logs on to an Essbase Deployment Services domain

signoff Logs off of an Essbase Deployment Services domain

apiver Displays the Essbase JAPI version number

apiverdetail Displays the Essbase JAPI version number, client version 
number, and compatibility information

adduser Adds a user to the root domain

changepwd Changes the password for a user

listusers Displays a list of all users that are registered in the root 
domain of the Essbase Deployment Services server

removeuser Removes a user from the root domain
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Uninstalling Essbase Deployment Services
You can uninstall Essbase Deployment Services from Windows systems and 
UNIX systems. This section shows you how to uninstall Essbase Deployment 
Services software from your computer or from a network drive.

addolapserver Adds a Essbase server to the root domain

listolapservers Lists the Essbase servers in the root domain

removeolapserver Removes an Essbase server from the root domain

setprompt Sets the prompt text for the Command Shell

synccubereplicas Synchronizes data among replicas of a Essbase application

syncsectoees Synchronizes security information from a Essbase server to 
the Essbase Deployment Services server

copyOlapApp Copies an Olap application from one host to another. 

copyCube Copies an Olap database from one host to another. 

createCluster Creates a new Olap server cluster.

deleteCluster Deletes an existing OLAP server cluster.

listClusters Lists all Olap server clusters.

getCluster Retrieves an Olap server cluster.

createConnPool Creates a a new connection pool.

deleteConnPool Deletes an existing connection pool.

listConnPools Lists all the existing connection pools.

getConnPool Retrieves a connection pool.

builddetail Retrieves details about this product build.

session Retrieves a list of users currently signed on.

Table 3: Command Shell Commands (Continued)

Commands Description
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Instructions for Uninstalling from Windows Systems
To uninstall Essbase Deployment Services, use the Windows Add/Remove 
Programs icon in the Control Panel.

➤ To uninstall Essbase Deployment Services from Windows 2000:

1. Select Start > Settings > Control Panel > Add/Remove Programs.

2. Select Change/Remove Programs, select the Essbase Deployment Services 
software you want to remove, and click Change/Remove.

3. Click Yes to confirm that you want to remove the program.

4. If a Remove Shared File? prompt appears, click Yes To All.

Windows removes the program and associated files. If some elements of the 
program could not be removed, click Details for more information.

5. Click OK.

Instructions for Uninstalling from UNIX Systems
To uninstall Essbase Deployment Services, use the uninstaller program created by 
the Essbase Deployment Services setup program. The uninstaller program requires 
a supported version of the Java Runtime Environment to be in the path.

➤ To uninstall Essbase Deployment Services from UNIX systems:

1. Log on to the computer where Essbase Deployment Services using the same 
user account that installed the software.

2. Move to the HYPERION_HOME/eds/Uninstall/ directory.

3. Execute the UninstallEDS file; for example, at the command prompt, type 
the following command:

>./UninstallEDS 

The uninstaller program removes the program and associated files.
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Configuring Essbase Deployment Services 
Servers

Before you can run Essbase Deployment Services servers, you must configure a 
database for storing domain information. For this purpose, Deployment Services 
installs the MySQL database in the HYPERION_HOME/common folder and 
configures it for use by default. 

You must also configure an Essbase Deployment Services server to use TCP/IP, 
HTTP, or EJB.

For information on configuring domain storage, see “Configuring Domain Storage 
for Essbase Deployment Services” on page 50. For information on configuring 
Essbase Deployment Services to use TCP/IP, HTTP, or EJB, see “Configuring 
Servers to Use TCP/IP, HTTP, or EJB” on page 53.

Configuring Domain Storage for Essbase Deployment 
Services

Essbase Deployment Services requires a place to store information about domains, 
including domain names, servers, users, and groups. Two mechanisms are 
available for storing domain information:

● Java Database Connectivity (JDBC)-compliant Relational Database 
Management System (RDBMS) such as MySQL.

● Flat file database, domain.db 

Essbase Deployment Services is configured to use the installed MySQL database 
by default.

Note: Before putting Essbase Deployment Services servers into production, you must 
configure them to use an RDBMS for domain information storage.

Configuring RDBMS Domain Storage
When you use Essbase Deployment Services in a production environment, you 
must use an RDBMS for domain storage. You must have RDBMS software 
installed, such as IBM DB2, to create and use an RDBMS domain storage. 
RDBMS software is not included with Essbase Deployment Services.
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To configure Essbase Deployment Services to use an RDBMS for domain 
storage, you must set up a database on the RDBMS server and edit the 
essbase.properties file.

➤ To configure an RDBMS database for domain storage:

1. Create a database called essbase in the RDBMS.

2. Add a user with full administrative rights to the database essbase; for example, 
db2admin with the password password.

Specific procedures for creating a new database varies with the RDBMS 
product you are using. For more information about creating a new database, 
see the documentation for the RDBMS product.

You do not need to create a database schema (tables and fields) in the new 
database. The database schema is created the first time Essbase Deployment 
Services successfully connects to the RDBMS.

➤ To configure domain storage to use an RDBMS database:

1. In the HYPERION_HOME\eds\bin directory, locate the 
essbase.properties file and open it in a text editor.

2. Set the domain.store.type variable to the value rdbms (all lower case); 
for example,

domain.store.type=rdbms 

3. Set the domain.store.rdbms variables to the appropriate values; for 
example,

domain.store.rdbms.product=DB2 
domain.store.rdbms.jdbc.driver=
COM.ibm.db2.jdbc.net.DB2Driver 
domain.store.rdbms.jdbc.url=
jdbc:db2:localhost:essbase 
domain.store.rdbms.user=db2admin 
domain.store.rdbms.password=password 
domain.store.rebms.connectionPool.capacity=2 

Verify that the user and password you specify in these fields is the same as 
those created in the RDBMS in the previous procedure.
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4. If you are using RDBMS as your Domain Storage, add the following jar/zip 
files to the CLASSPATH statement:

● For DB2: db2java.zip 

● For SQL: JSQLConnect.jar 

● For Oracle: classes12.zip 

● For MySQL: mysql-connector-java-3.0.8-stable-bin.jar 

5. Save essbase.properties and close the file.

The essbase.properties file contains sample settings for DB2, Oracle, and 
SQL Server systems. Use the sample settings as a starting point for configuring the 
connection to your RDBMS database. For more information about configuring a 
JDBC connection to an RDBMS, refer to the documentation for the RDBMS 
product.

Configuring Flat File Domain Storage 
To configure Essbase Deployment Services to use a flat file for domain storage, 
you must edit the essbase.properties file.

➤ To configure domain storage to use a flat file:

1. In the HYPERION_HOME\eds\bin directory, locate the 
essbase.properties file and open it in a text editor.

2. Set the domain.store.type variable to the value file; for example,

domain.store.type=file 

3. Set the domain.store.file.name variable to the full path and file name of 
the domain storage file; for example,

domain.store.file.name=
c:/HYPERION_HOME/eds/data/domain.db 

4. Save essbase.properties and close the file.
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Configuring Servers to Use TCP/IP, HTTP, or EJB
Essbase Deployment Services servers can run using TCP/IP, HTTP, or EJB 
configurations. Each of these types of implementations requires additional 
software components and configuration of these components. The type of server 
you set up depends on the type of client program technology you plan to use with 
Essbase Deployment Services. If you simply want to start working with Essbase 
Deployment Services, use either the default HTTP or TCP/IP configurations, 
which are created by the installation program.

For more information on the use of TCP/IP, HTTP, or EJB technology with 
Essbase Deployment Services, see “Understanding the Essbase Deployment 
Services Development Platform” on page 16.

The following sections explain how to create Essbase Deployment Services 
servers in these configurations:

● TCP/IP running Deployment Services as a stand-alone program.

● HTTP using Tomcat to run Deployment Services as a servlet. For more 
informaion see, “Deploying on Apache Tomcat Server” on page 67.

● EJB using WebLogic to run Deployment Services as an EJB. For more 
information see“Deploying on BEA WebLogic Server 8.x” on page 69

For information on running the server configurations described here, see “Starting 
and Stopping Essbase Deployment Services Servers” on page 74.

Configuring TCP/IP Servers
The installation program creates a TCP/IP implementation of Essbase Deployment 
Services automatically. In this configuration, the Essbase Deployment Services 
server runs as a stand-alone program and does not require any additional software.

Note: Essbase Deployment Services client programs communicating with TCP/IP 
configurations of the server are configured to use 5001 by default. That can be changed 
by editing the essbase.properties file in the /eds/bin directory. 
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➤ To configure a TCP/IP server:

1. In the HYPERION_HOME\eds\bin directory, locate the 
essbase.properties file and open it in a text editor.

2. Set the system.dataDir variable to the Essbase Deployment Services data 
directory; for example,

system.dataDir=../data 

3. Verify that the domain storage is configured.

For more information about configuring domain storage, see “Configuring 
Domain Storage for Essbase Deployment Services” on page 50.

4. Save essbase.properties and close the file.

For information on starting Essbase Deployment Services TCP/IP servers, see 
“Starting and Stopping TCP/IP Servers” on page 74.

Configuring Essbase Analytic Servers
Before using Essbase Analytic servers with Essbase Deployment Services, you 
must configure the Essbase Analytic servers to better support concurrent usage, 
create replicas of your application, and create users for Essbase Deployment 
Services. In addition, for Essbase servers running on Windows systems, you 
should configure them for remote activation.

➤ To configure Essbase servers for use with Essbase Deployment Services:

1. On the computer running Essbase server, in the ARBORPATH\bin directory, 
locate the essbase.cfg file. If the essbase.cfg file does not exist, create 
one using a text editor.

2. For Essbase servers used in a production system with Essbase Deployment 
Services, consider adding the following lines to the essbase.cfg file:

AGENTLOGMESSAGELEVEL ERROR 
LOGMESSAGELEVEL ERROR 

These settings reduce the amount of messages that are logged by the Essbase 
Analytic server. Under heavy use, Essbase logs can become very large and 
unusable by the server, requiring that you delete the log or reduce its size. 
Adding these settings will reduce the amount of information recorded in the 
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logs and, consequently, reduce the need to manage the logs. To permanently 
solve problems with overlarge log files, consider adding the following line to 
the essbase.cfg file:

CLEARLOGFILE TRUE 

The CLEARLOGFILE setting causes Essbase to clear the log file before 
recording any new message, so that only the last message is available in the 
log file. For more information about these essbase.cfg file settings, see the 
Technical Reference. 

3. If you plan to use Essbase servers in a cluster configuration with Essbase 
Deployment Services, you must make copies of the Essbase application that 
the cluster will serve on each of the Essbase servers in the cluster.

To gain a minimal benefit of load balancing and failover from Essbase 
Deployment Services, you must set up at least a main application with a 
database and one replica application with an identical database. For more 
information about setting up clusters, see “Defining Clusters and Connection 
Pools” on page 57.

For more information about copying Essbase applications, see the Essbase 
Analytic Services Database Administrator’s Guide.

4. Create users and their access permissions on each of the Essbase servers to use 
with Essbase Deployment Services.

For more information about creating users in Essbase, see the Essbase 
Analytic Services Database Administrator’s Guide.

For more information about creating users across a cluster of Essbase servers, 
see “Synchronizing Users and Security Across a Cluster” on page 80.

Configuring Essbase Servers for Remote Activation
You can enable Essbase Deployment Services to start an Essbase Analytic server 
on a remote Windows system. You need to have the appropriate privileges and you 
must specify the exact path of the Essbase Analytic server on the remote machine. 
This feature uses DCOM activation on both machines. 
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➤ To configure remote activation of Essbase Analytic servers on Windows systems:

1. Run the batch file regact.cmd in the HYPERION_HOME\eds\bin directory. 
This updates the registry to enable DCOM activation.

2. Copy regact.cmd and eds_rexec.exe to the /bin directory of the remote 
Essbase server. Run regact.cmd (it calls eds_rexec.exe). 

3. Edit the file startolap.cmd in the HYPERION_HOME\eds\bin. The 
ARBORPATH entry must specify the path of the HYPERION_HOME directory 
on the remote machine. The entries in the startolap.cmd file should appear 
as follows:

@echo off
REM This command file is used to start the Essbase OLAP server.
REM Make sure to change the ARBORPATH to suit your setup.
REM For remote activation set ARBORPATH to point to the remote
machine.
set ARBORPATH=C:\hyperion\essbase
set PASSWORD=%1
set PATH=%ARBORPATH%\bin;%PATH%;essbase %PASSWORD%

4. Copy startolap.cmd to the /bin directory of the remote Essbase server.

5. Using the Deployment Services Console, add the remote Essbase server to the 
Enterprise Services domain. Set the server property named Remote start 
command to HYPERION_HOME\eds\bin\startolap.cmd <password> 
(for example, c:\essbase\eds\bin\startolap.cmd password. Save 
the server properties. 

6. Edit startees.cmd and make sure all directories are specified as absolute 
paths. 

7. Edit the essbase.properties file to replace system.dataDir=..\data 
with the absolute path. For example, c:\essbase\eds\data. 

8. In the EDS Console, add the Deployment server to the Essbase Deployment 
domain, and set the Remote start command property to the absolute path of the 
startees.cmd file. 

9. Remote activation is now enabled. From the EDS Console, select olap or 
deployment server, and select Control > Start. 
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Defining Clusters and Connection Pools
Essbase server clusters and connection pools enable Essbase Deployment Services 
to provide features of load balancing, failover, and handling of large concurrent 
loads. If you do not use clusters and connection pools in your client programs, you 
are not taking advantage of the primary benefits of using Essbase Deployment 
Services.

A cluster of Essbase servers is a set of servers running on different computers (or 
different CPUs, on multi-processor systems) that run copies, or replicas, of the 
same Essbase application, a single Essbase server that runs replicas of the same 
application, or a combination of both.

A connection pool is set of login sessions from Essbase Deployment Services to a 
Essbase server. Deployment Services uses a connection pool to process requests 
for Essbase services.

Clusters and connection pools are defined in the essbase.properties file and 
can be used only through client programs. In general, client programs should take 
advantage of clusters and connection pools by using connection pools that include 
clusters. Thus, in general, you should include a cluster in your connection pool to 
take full advantage of the features of Essbase Deployment Services.

For an example of a client program that uses connection pools and clusters, refer 
to the DataQuery sample program in the HYPERION_HOME\eds\samples 
directory. For more information about the sample programs, see Chapter 6, 
“Setting up the Sample Programs.” For more information about using clusters and 
connection pools in client programs, see the IEssCube.openCubeView method and 
related methods in the online Essbase Deployment Services JAPI Reference in the 
Essbase Deployment Services DOCS directory. 

Defining Essbase Server Clusters
Essbase servers must be configured to be used effectively with Essbase 
Deployment Services. For more information about configuring Essbase servers for 
use in a cluster, see “Configuring Essbase Analytic Servers” on page 54.

Essbase Deployment Services enables you to group sets of Essbase servers 
running applications with identical databases and use them as a single resource in 
your client programs. Clustering of servers enables features such as load balancing 
and failover support. Load balancing enables requests to Essbase servers to be 
distributed across a cluster of Essbase servers running identical databases. Failover 
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support detects service interruptions in a cluster, and reroutes requests to other 
available Essbase servers in a cluster. You must restart the server to reflect changes 
to the cluster.

➤ To define a cluster:

1. In the left pane of the Deployment Services Console, select a domain under 
Domains or select Clusters if clusters have already been created.

2. Right-click, then select Create > Cluster.

3. In the dialog that is displayed, type the name for your cluster; for example, 
mycluster.

4. Click OK. 

5. In the left pane, select the cluster that you have just created.

6. In the cluster’s properties panel, set the service component name; for example, 
localhost/Demo/Basic;localhost/Demo2/Basic.

7. Click Save.

8. Specify the cluster name in the properties panel of the Enterprise Services 
server for which you want to associate the cluster.

After configuring a set of Essbase servers for use in a cluster, you must define and 
enable the cluster in the Deployment Services Console. For complete instructions 
on configuring clusters refer to the online Essbase Deployment Services Console 
Help in the Essbase Deployment Services DOCS directory.

Defining Connection Pools
Connection pools are defined in the Deployment Services Console. For complete 
information on configuring connection pools refer to the online Essbase 
Deployment Services Console Help in the Essbase Deployment Services DOCS 
directory.

Essbase Deployment Services enables client requests to share connections, which 
conserves software and network resources, and improves performance. You must 
restart the Enterprise Services server to reflect changes to the connection pool.
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➤ To define a connection pool:

1. In the left pane of the Deployment Services Console, select a domain under 
Domains or select Connection Pools if connection pools have already been 
created.

2. Right-click, then select Create > Connection Pool.

3. In the dialog that is displayed, type the name for your connection pool; for 
example, mypool.

4. Click OK. 

5. In the navigation panel, select the connection pool that you have just created.

6. In the connection pool's properties panel, set the service component name for 
the cluster associated with the connection pool; for example, mycluster.

7. Enable the check box for the service component.

8. Enter the username and password.

9. Set the initial capacity, maximum capacity, capacity increment.

10. Specify whether to enable access for everyone.

11. Click Save.

12. Specify the connection pool name in the properties panel of the Enterprise 
Services server you want to associate with the connection pool.

Deploying Deployment Services on Application 
Servers

This section describes what you need to do to configure Essbase Deployment 
Services and deploy it within the Apache Tomcat application server or other 
supported application servers. 

There are three steps to the configuration and deployment:

1. Making Configuration Changes

2. Setting ARBORPATH and PATH on Windows or on UNIX

3. Configuration of the application server environment and Essbase Deployment 
Services, as described in “Before Deploying on an Application Server” on 
page 62, and deployment on application servers 
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Making Configuration Changes
Open the essbase.properties file located in the 
$HYPERION_HOME/eds/7.1.0.0/bin/ folder and replace all the relative 
path references (../essbase) to the full path of the location of Essbase 
Deployment Services. 

For example, system.dataDir=../data should be changed to 
system.dataDir=c:/HYPERION_HOME/eds/7.1.0.0/data. 

Copy the Essbase configuration file (essbase.cfg) from the target 
Essbase database to the Deployment Services essbase folder. Find the 
file c:/Hyperion/essbase/bin/essbase.cfg and copy that file to 
c:/Hyperion/eds/7.1.0.0/essbase/bin/essbase.cfg. 

Setting ARBORPATH and PATH on Windows
Before configuring the application server to host Deployment Services, the 
ARBORPATH and PATH environment variables have to be configured properly. 

1. Set the ARBORPATH variable to $HYPERION_HOME/essbase. 

2. Add $HYPERION_HOME/eds/bin and $ARBORPATH\bin to the system path. 

Examples: 

If Deployment Services is installed in c:\hyperion\essbase\eds add the 
following environment variables: 

SET ARBORPATH=c:\hyperion\essbase\eds\essbase

SET PATH=
%ARBORPATH%\bin;c:\hyperion\essbase\eds\bin;%PATH

Setting ARBORPATH and PATH on UNIX
Before configuring the application server to host Deployment Services, the 
ARBORPATH and Library path environment variables have to be configured 
properly. You can set these parameters through your .bashrc, .cshrc, or 
.profile depending on the shell you are using. 

Make sure these parameters are set before starting the application server 
configuration. The following examples are for bash shell. 
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AIX
1. Set ARBORPATH to $HYPERION_HOME/eds/essbase 

2. Set LIBPATH to 
$HYPERION_HOME/eds/bin:$HYPERION_HOME/eds/essbase/bin 

Examples: 

For Deployment Services installed in /export/home/eds, add the following 
environment variables: 

export ARBORPATH=/export/home/eds/essbase

export LIBPATH=
/export/home/eds/bin:/export/home/eds/essbase/bin:$LD_LI
BRARY_PATH 

HP-UX
1. Set ARBORPATH to $HYPERION_HOME/eds/essbase 

2. Set SHLIB_PATH to 
$HYPERION_HOME/eds/bin:$HYPERION_HOME/eds/essbase/bin 

Examples: 

For Deployment Services installed in /export/home/eds, add the following 
environment variables: 

export ARBORPATH=/export/home/eds/essbase

export SHLIB_PATH=
/export/home/eds/bin:/export/home/eds/essbase/bin:$LD_LI
BRARY_PATH 

Solaris
1. Set the ARBORPATH variable to $HYPERION_HOME/eds/essbase 

2. Set LD_LIBRARY_PATH to 
$HYPERION_HOME/eds/bin:$HYPERION_HOME/eds/essbase/bin 
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Examples: 

For Deployment Services installed in /export/home/eds, add the following 
environment variables: 

export ARBORPATH=/export/home/eds/essbase

export LD_LIBRARY_PATH=
/export/home/eds/bin:/export/home/eds/essbase/bin:$LD_LI
BRARY_PATH 

Linux
1. Set the ARBORPATH variable to $HYPERION_HOME/eds/essbase

2. Set LD_LIBRARY_PATH to 
$HYPERION_HOME/bin:$HYPERION_HOME/essbase/bin

Examples:

For Deployment Services installed in /export/home/eds, add the following 
environment variables:

export ARBORPATH=/export/home/eds/essbase

export LD_LIBRARY_PATH=
/export/home/eds/bin:/export/home/eds/essbase/bin:$LD_LI
BRARY_PATH

Before Deploying on an Application Server
Before you begin deploying Essbase Deployment Services on an application 
server, you must perform the following tasks: 

● Update the application server environment for Deployment Services

See “Updating the Application Server Environment” on page 63.

● Extract the contents of the Deployment Services .war file, edit the web.xml 
file to specify the location of the location of the Deployment Services 
installation and customize the Deployment Services options that you require, 
and then repack the .war file. 

See “Updating eds.war and web.xml” on page 65.

These tasks assume that you have already installed Deployment Services and your 
application server.
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Updating the Application Server Environment
Make updates to your application server environment by editing the startup or 
configuration file appropriate to your application server, as listed below:

● WebLogic: StartWLS.cmd (startup file)

Located by default in WL_HOME>\weblogic81\server\bin

● WebSphere: setupCmdline.bat (startup file)

Located by default in \websphere\appserver\bin 

● Sun One: asenv.conf (configuration file)

Located by default in etc/opt/SUNWappserver7/ 

➤ To update the application server environment for Deployment Services:

1. Edit the startup or configuration file appropriate to your application server as 
follows:

set ESS_ES_HOME=c:\Hyperion\eds
// Set ESS_ES_HOME to the absolute path of EDS_HOME;
// for example, if you have installed Deployment Services
// at c:\Hyperion\eds, then ESS_ES_HOME=c:\Hyperion\eds

set ARBORPATH=%ESS_ES_HOME%\essbase

set THIRDPARTY=%ESS_ES_HOME%\external

set J2EE_LIBS=
%THIRDPARTY%\j2ee\activation.jar;%THIRDPARTY%\j2ee\mail.jar;

set MYSQL=
%THIRDPARTY%\mysql-connector-java-3.0.8-stable-bin.jar;

set CSS=
%THIRDPARTY%\css\css-2_5_3.jar;%THIRDPARTY%\css\jdom.jar;
%THIRDPARTY%\css\log4j-1.2.7.jar;

set CLASSPATH=
%ESS_ES_HOME%\lib\ess_japi.jar;%ESS_ES_HOME%\lib\
ess_es_server.jar;%J2EE_LIBS%;%MYSQL%;%CSS%;
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Note: Add the following jar/zip files to the CLASSPATH statement based on your 
RDBMS domain storage:

For DB2: 

db2java.zip 

For SQL: 

JSQLConnect.jar 

For Oracle: 

classes12.zip 

For MySQL: 

mysql-connector-java-3.0.8-stable-bin.jar 

Note: Be sure to include the PATH statement for your operating system as follows:

For Windows: 

set PATH=%ESS_ES_HOME%\bin;%ARBORPATH%\bin;%PATH%; 

For AIX: 

LIBPATH=
$HYPERION_HOME/eds/bin:$HYPERION_HOME/eds/essbase/bin 

For HP-UX: 

SHLIB_PATH=
$HYPERION_HOME/eds/bin:$HYPERION_HOME/eds/essbase/bin 

For Solaris and Linux: 

LD_LIBRARY_PATH=
$HYPERION_HOME/eds/bin:$HYPERION_HOME/eds/essbase/bin 

2. Ensure that the essbase.properties file 
(EDS_HOME\bin\essbase.properties) specifies the absolute 
path of EDS_HOME for the following properties:

system.dataDir=../data 
system.arborPath=../essbase 



Deploying Deployment Services on Application Servers

4

■ 65Essbase Deployment Services Installation Guide

Updating eds.war and web.xml

➤ To update the .war file and edit the web.xml file:

1. Copy the eds.war file, located by default in 
HYPERION_HOME\eds\7.1.0.0\redist, to a temporary 
directory and unpack it using the following command: 

jar -xvf eds.war 

The .war file is located by default in the 
HYPERION_HOME\eds\7.1.0.0\redist folder.

Note: It is recommended that you make a backup of the eds.war file.

2. Delete the .war file that was copied into the temporary directory.

3. Edit the web.xml file that was unpacked into the temporary directory to 
add essbase.properties as a servlet parameter, specifying the 
absolute path of the essbase.properties file.

The following is an example from the web.xml file with 
essbase.properties added as a servlet parameter using the absolute path 
of the essbase.properties file.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE web-app PUBLIC "-
//Sun Microsystems, Inc.//DTD Web Application 2.2
//EN" "http://java.sun.com/j2ee/dtds/web-app_2_2.dtd">
<web-app id="WebApp_ID">
   <display-name>EDSWebModule</display-name>
   <servlet id="Servlet_1">
     <servlet-name>EssbaseEnterprise</servlet-name>
     <servlet-class>
        com.essbase.server.plugins.http.EssbaseEnterprise
     </servlet-class>
   <init-param>
   <param-name>essbase.properties</param-name> 
   <param-value>
     C:/Hyperion/eds/7.1.0.0/bin/essbase.properties
   </param-value>
   </init-param>
   </servlet>
     <servlet-mapping id="ServletMapping_1">
     <servlet-name>EssbaseEnterprise</servlet-name>
     <url-pattern>/EssbaseEnterprise</url-pattern>
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     </servlet-mapping>
</web-app>

4. If you are using a relational database for your domain storage, copy the 
appropriate .jar or .zip file from the RDBMS product files to the 
WEB-INF\lib directory. 

For DB2: 

db2java.zip

Note: The db2java.zip file must be renamed db2java.jar when you copy 
it to the WEB-INF\lib directory.

For SQL: 

JSQLConnect.jar

For Oracle: 

classes12.zip

Note: The classes12.zip file must be renamed to classes12.jar when 
you copy it to the WEB-INF\lib directory.

For MySQL: 

mysql-connector-java-3.0.8-stable-bin.jar

5. Save the web.xml file.

6. Repack the eds.war file using the following command: 

jar -cvf eds.war .

7. Optional. Copy the eds.war file back to the original location; typically the 
HYPERION_HOME\eds\7.1.0.0\redist folder.

8. Restart the application server program.

After you complete this procedure, you are ready to begin deploying Deployment 
Services on your application server. 
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Deploying on Apache Tomcat Server
Apache Tomcat 4.1 is included with Deployment Services and is installed and 
configured by default. The procedure in this section can be used to validate the 
installation. 

If you have an existing installation of Apache Tomcat that want to deploy and 
configure for use with Deployment Services, complete the steps in “Before 
Deploying on an Application Server” on page 62, and then perform the following 
steps.

➤ To deploy the Essbase Deployment Services files to Apache Tomcat Server:

1. If Apache Tomcat is already running, stop the application server. 

2. Copy C:\Hyperion\7.1.0.0\eds\redist\eds.war file from 
$HYPERION_HOME\eds\redist to the \tomcat\4.1.18\webapps 
directory. 

3. Copy the essbase.properties file to the /bin folder of Tomcat. 

4. Start Apache Tomcat to complete the deployment process. 

5. Start Deployment Services and verify that you have successfully deployed 
Essbase Deployment Services by entering the URL for Deployment Server 
into a browser.

Note: To validate that you have successfully installed and deployed the 
application server that you are using, go to http://<hostname>:<port 
number>/eds/EssbaseEnterprise to verify that the Deployment Server 
is up and running. 

For example, for Essbase Deployment Services deployed with the context root 
name “eds” and the HTTP port on which Deployment Server is 7001:

http://localhost:7001/eds/EssbaseEnterprise

Deploying on BEA WebLogic Server 7.x
If you plan to use the BEA WebLogic application server with Deployment 
Services, complete the steps in “Before Deploying on an Application Server” on 
page 62, then start the WebLogic server and then perform the following steps. 
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➤ To deploy the Essbase Deployment Services files to WebLogic Server 7.x:

1. In the WebLogic navigation frame, click mydomain, then click Applications. 

2. From the menu displayed, select Configure a New Application. 

3. On the Locate Application or Component to Configure page of the 
configuration wizard, select upload it through your browser. This will 
enable you to upload the Deployment Server .war file and deploy to the 
WebLogic server. 

4. On the Install or Update an Application page of the configuration wizard, 
click Browse to navigate to the .war file. 

5. Navigate to $HYPERION_HOME\eds\redist\eds.war. 

6. The installation process returns you to the Locate Application or 
Component to Configure page of the configuration wizard, and the eds.war 
file is displayed in the list of the WebLogic ...\server\bin files. 

7. Click Select next to the eds.war file to select it from the list. This displays 
the Configure Application or Component to Configure page of the 
configuration wizard. 

8. In the Available Servers list box, select the server to configure, then enter a 
name for the application in the Target Servers text box to the right, and click 
Configure and Deploy. 

9. Copy the essbase.properties file from $HYPERION_HOME\eds\bin to 
the location of the startweblogic.cmd (or startWebLogic.sh for 
UNIX). For example, if you are using the default domain, mydomain, the 
startwebLogic.cmd is in c:\bea\user_projects\mydomain. 

10. Start Deployment Services and verify that you have successfully deployed 
Essbase Deployment Services by entering the URL for Deployment Server 
into a browser.

Note: To validate that you have successfully installed and deployed the 
application server that you are using, go to http://<hostname>:<port 
number>/eds/EssbaseEnterprise to verify that the Deployment Server 
is up and running. 

For example, for Essbase Deployment Services deployed with the context root 
name “eds” and the HTTP port on which Deployment Server is 7001:

http://localhost:7001/eds/EssbaseEnterprise
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Deploying on BEA WebLogic Server 8.x 
If you plan to use the BEA WebLogic application server with Deployment 
Services, complete the steps in “Before Deploying on an Application Server” on 
page 62, and then perform the following steps. 

➤ To deploy the Essbase Deployment Services files to WebLogic Server 8.x:

1. Start Weblogic Server 8.1 and sign on to the WebLogic Server console.

2. In the WebLogic navigation frame, select mydomain, then select 
Deployments > Web Application Modules.

3. On the Web Applications page, ensure that the Configuration tab is selected 
and click the Deploy a new Web Application Module link to deploy a new 
web module.

4. On the Deploy a Web Application Module page, click the myserver folder 
link to select the myserver domain.

5. Click the upload link to upload the the eds.war file.

6. On the Upload and Install an Application or Module page, click the 
Browse button to navigate to the location of the redist folder containing the 
eds.war file; for example, C:\Hyperion\eds\redist\eds.war), and 
then click the Upload button.

7. In Select the archive for this Web application module, click the Myserver 
folder, then click the upload folder link.

8. Select the radio button for the eds.war file and click the Target Module 
button.

9. In Review your choices and deploy, verify that the information under 
Deployment Targets, Source Accessibility, and Identify is correct and click 
the Deploy button.

A “Success” status is displayed on the message page. 

10. Log out from the WebLogic Server console and restart the WebLogic Server.
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11. Start Deployment Services and verify that you have successfully deployed 
Essbase Deployment Services by entering the URL for Deployment Server 
into a browser.

Note: To validate that you have successfully installed and deployed to the 
application server that you are using, go to http://<hostname>:<port 
number>/eds/EssbaseEnterprise to verify that the Deployment Server 
is up and running. 

For example, if Essbase Deployment Services is deployed with “eds” as the 
context root name “eds” and 7001 as the HTTP port on which Deployment 
Server:

http://localhost:7001/eds/EssbaseEnterprise

Deploying on IBM WebSphere Enterprise Server 
5.0.x or 5.1.x

If you plan to use the WebSphere Enterprise Server 5.0.x or 5.1 application server 
with Deployment Services, complete the steps in “Before Deploying on an 
Application Server” on page 62, then start the WebSphere and perform the 
following steps.

➤ To deploy the Essbase Deployment Services files to WebSphere Enterprise Server 
5.0.x:

1. Bring the up the WebSphere Administrative Console by typing the following 
URL in a browser. For example:

http://<hostname>:<port number>/admin

2. In the Login window, type your user ID in the text box and click OK.

3. In the left frame of the Administrative Console, select Applications > Install 
New Application.

4. On the Preparing for the application installation page, click Browse and 
navigate to the $HYPERION_HOME\eds\redist\eds.war file. 

5. In the Context Root text box, type /eds and click Next. 

Note: If you do not want any context root, you must stop all the default applications 
except the adminstrative application because “/” is used by one of the applications.
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6. In the Generate Default Bindings box, click Next to accept the default 
values. 

7. In the Step 1 Provide options to perform the installation box, click Next to 
accept the default values shown in the AppDeployment Options box. 

8. In the Step 2 Map virtual hosts for web modules box, click 
EDSWebModule to select it as the default host, then click Next. 

9. In the Step 3 Map modules to application servers box, check 
EDSWebModule, to indicate eds.war is the module to map to the 
WebSphere server, and then click Next. 

10. In the Step 4 Summary box, click Finish to initiate the installation. When the 
installation is completed, a message advises you that the eds_war application 
is successfully installed. 

11. Click the Save to Master Configuration option to enable startup of 
Deployment Server, then click the Save button. 

12. In the left frame, select Applications > Enterprise Applications. 

13. When the Enterprise Applications page is displayed, select the check box 
next to eds.war, and then click Start to start Deployment Server. 

14. Verify that you have successfully deployed Essbase Deployment Services by 
entering the URL for Deployment Server into a browser.

Note: To validate that you have successfully installed and deployed the 
application server that you are using, go to http://<hostname>:<port 
number>/eds/EssbaseEnterprise to verify that the Deployment Server 
is up and running. 

Deploying on a Sun ONE Application Server
If you plan to use the Sun™ ONE application server 7.0 with Essbase Deployment 
Services, complete the steps in “Before Deploying on an Application Server” on 
page 62, then start the Sun ONE application server, and perform the following 
steps. 

➤ To deploy the Essbase Deployment Services files to Sun ONE 7.0:

1. Install and start the Sun ONE application server.

2. In the navigation frame of the Sun ONE Administrative Console, navigate to 
Web Apps under server1->applications. 
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3. On the Applications page, click Deploy. 

4. On the Upload WAR File page, click Browse and navigate to the 
$HYPERION_HOME\eds\redist\eds.war file. Click OK. 

5. In the Server1:Applications:Web:Deploy page, click OK accept the default 
values. 

6. Copy the essbase.properties file from $EDS_HOME\bin to the 
configuration folder of your application server domain. For example, for 
default installation, copy the essbase.properties file to the 
AppServer\domains\domain1\server1\config folder of your Sun 
ONE installation. 

7. Modify the policy of your virtual server to allow reading and writing of 
properties. Open the server.policy file located in the 
AppServer\domains\domain1\server1\config folder and search for 
the string permission java.util.PropertyPermission "*", "read 
";. Change it to permission java.util.PropertyPermission "*", 
"read,write";. 

8. Restart the Sun ONE application server for the settings to take effect. 

9. Verify that you have successfully deployed Essbase Deployment Services by 
entering the URL for Deployment Server into a browser.

Note: To validate that you have installed and deployed the application 
server that you are using, go to http://<hostname>:<port 
number>/eds/EssbaseEnterprise to verify that your Essbase 
Deployment server is up and running. 
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5

Chapter

5
System Administration

This chapter discusses administration tasks for system administrators of Essbase 
Deployment Services, including managing data and security information in a 
Essbase server cluster.

● “Starting and Stopping Essbase Deployment Services” on page 74

– “Starting and Stopping Essbase Deployment Services Servers” on 
page 74

– “Starting and Stopping the Deployment Services Console” on page 75

– “Starting and Stopping the Deployment Services Command Shell” on 
page 76

● “Managing Essbase Server Clusters” on page 77

– “Outline Caching” on page 77

– “External Authentication” on page 78

– “Disk Space Management” on page 78

– “Synchronizing Data Across a Cluster” on page 78

● “Fault Tolerance” on page 82
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Starting and Stopping Essbase Deployment 
Services

Essbase Deployment Services contains several software components in that you 
must start and stop separately. Depending on the configuration of the Essbase 
Deployment Services server, there are different procedures for starting and 
stopping it. For more information about starting Essbase Deployment Services 
server, see “Starting and Stopping Essbase Deployment Services Servers” on 
page 74.

For information about starting Essbase servers, see the Essbase Analytic Services 
Installation Guide.

After the preceding software components have been started, you can start the 
following components in any order:

● Essbase Deployment Services Console

● Essbase Deployment Services Command Shell

● Essbase Deployment Services client programs

Starting and Stopping Essbase Deployment Services 
Servers

This section describes how to start and stop the following Essbase Deployment 
Services server configurations:

● TCP/IP servers

● HTTP/Tomcat servers

For more information about configuring the different types of Essbase 
Deployment Services servers, see “Configuring Servers to Use TCP/IP, HTTP, or 
EJB” on page 53.

Starting and Stopping TCP/IP Servers
Essbase Deployment Services servers can be started from the Start menu on 
windows by selecting Start > Programs > Hyperion Solutions > Essbase 
Deployment Services>Start Essbase Deployment Server - TCPIP. 
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An Essbase Deployment Services server can also be started in TCP/IP mode by 
running a command script. For information about configuring the command script, 
see “Configuring TCP/IP Servers” on page 53.

➤ To start a Deployment Sever in TCP/IP mode:

1. At a command prompt, change to the HYPERION_HOME\eds\bin directory, 
locate the startees file (.cmd on Windows systems, .sh on UNIX 
systems).

2. Run the startees file with the input parameter TCPIP; for example:

>startees tcpip 

➤ To stop a TCP/IP server:

1. Click the window for the TCP/IP server and press Enter.

2. At the prompt, type exit and press Enter.

Starting and Stopping HTTP/Tomcat Servers
Essbase Deployment Services servers can be started from the Start menu on 
windows by selecting Start > Programs > Hyperion Solutions > Essbase 
Deployment Services > Start Essbase Deployment Server - HTTP. 

Starting and Stopping the Deployment Services Console
The Essbase Deployment Services Console is a graphical interface that enables 
you to manage Essbase Deployment Services domains, servers, users, and groups. 
You must have a Essbase Deployment Services server running to start the Console.

For more information about using the Console, see the online Essbase Deployment 
Services Console Help in the Essbase Deployment Services DOCS directory.

➤ To start the Console:

1. Verify that the Essbase Deployment Services server is running.

2. In the HYPERION_HOME\eds\bin directory, locate the startgui file 
(.cmd on Windows systems, .sh on UNIX systems).

3. Run the startgui file.

4. In the User Name field, type a user name; for example, system.
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5. In the Password field, type a password; for example, password.

6. In the Domain field, type the name of a Essbase Deployment Services 
domain; for example, essbase.

The default domain for Essbase Deployment Services is essbase.

7. In the URL field, enter the URL to the Essbase Deployment Server. For 
example, http://localhost:8080/eds/EssbaseEnterprise or 
tcpip://localhost:5001. The TCP/IP port is changed by editing the  
essbase.properties file in the HYPERION_HOME\eds\bin directory.

8. Click Sign On to log on to the Essbase Deployment Services server and start 
the Console.

➤ To stop the Console, in the Console window, select File > Exit.

Starting and Stopping the Deployment Services 
Command Shell

The Essbase Deployment Services Command Shell is a command-line interface 
that provides basic tools to manage Essbase Deployment Services servers and 
users. You must have an Essbase Deployment Services server running to start the 
Command Shell.

For more information about using the Command Shell commands, see “Command 
Shell Commands” on page 47.

➤ To start the Command Shell:

1. Verify that the Essbase Deployment Services server is running.

2. In the HYPERION_HOME\eds\bin directory, locate the startcmd file (.cmd 
on Windows systems, .sh on UNIX systems).

3. Run the startcmd file.

4. At the prompt, use the signon command to log on to the Essbase Deployment 
Services server; for example, type:

ESS>signon 
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5. At the next prompt, type an Essbase Deployment Services user name, 
password, domain name, server name, and server type, separated by commas; 
for example,

admin,password,essbase,sequoia2, port# 

6. Press Enter to log on to the Essbase Deployment Services server.

➤ To stop the Command Shell, in the Command Shell window at the prompt, type 
Exit.

Managing Essbase Server Clusters
Using Essbase Deployment Services with clusters of Essbase servers creates a new 
set of tasks for Essbase system administrators. In particular, administrators must 
develop strategies for synchronizing data and security information across multiple 
Essbase servers.

The Essbase Deployment Services and Essbase teams are working toward 
solutions to these server management challenges. In the meantime, the following 
sections provide strategies for managing data and security synchronization.

Outline Caching
Essbase Deployment Services has the option of storing outline information along 
with other services information. This option makes it possible to keep the outline 
of a specific Essbase database locally on the Deployment Server eliminating 
unnecessary queries of the database itself.  This option is enabled through the 
Essbase Deployment Services console and can be set and reset as required. Outline 
Caching is set by specifying the absolute path to the specific Essbase Olap Server.  
For more information refer to the Essbase Deployment Services Console Help.
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External Authentication
Essbase Deployment Services allows the authentication of users external to the 
security measures present in the Essbase database itself. Security authentication of 
users can be done through two different schemes: 

● Native—Essbase Deployment server authentication (default). 

● External—The Hyperion security platform components can be configured to 
enable the authentication of users on Hyperion systems. For more information, 
see the “Security Platform Reference” section of the Essbase Analytic 
Services Technical Reference.

The native internal authentication by Essbase Deployment Services is the default 
scheme.  

Disk Space Management
Essbase Deployment Services uses temporary directories (on Windows  
HYPERION_HOME\eds\temp, HYPERION_HOME/eds/tmp on UNIX) to store 
databases and outlines. Even though the duration of the usage can be short, the 
outlines and databases can require large amounts of temporary physical disk space. 
Memory and disk space must be allocated to take into account the sizes of typical 
databases and outlines.

Synchronizing Data Across a Cluster
There are three general strategies for replicating data across a cluster:

● Using the features of Essbase Partitioning to create replicated partitions of the 
served application on each Essbase server

● Using Essbase Integration Server to load data onto each server in the cluster

● Exporting data from the master server and loading it into each Essbase server
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Synchronizing Data Using Partitioning
The Essbase Partitioning module enables you to create replicated partitions of a 
database over multiple Essbase servers. By creating replicated database partitions 
which mirror each other on each of the servers in a Essbase server cluster, you can 
effectively synchronize data across multiple Essbase servers.

For more information about using Partitioning, see the Essbase Analytic Services 
Database Administrator’s Guide.

Synchronizing Data Using Essbase Integration Server
Essbase Integration Server enables you to load data into Essbase databases quickly 
and easily. If you use Essbase Integration Server to load and update your master 
Essbase application for a cluster, you can also use it to load and update the other 
mirror application on the other Essbase servers in a cluster.

For more information about using Essbase Integration Server, see the Essbase 
Integration Services System Administrator’s Guide.

Synchronizing Data Using Export and Load Functions
Essbase provides a basic solution to synchronizing data between servers in the data 
export and import features. Using this methodology you export the data from the 
master Essbase database and import it into the other servers in the cluster.

Essbase Deployment Services provides a command to perform this type of 
synchronization in the Command Shell. This command uses the Essbase JAPI 
method IEssDomain.syncCubeReplicas(). A sample client program demonstrating 
this method is provided in the HYPERION_HOME\eds\samples directory. The 
sample program file is named SyncCubeReplicas.java.

For more information about the Command Shell, see “Command Shell 
Commands” on page 47. For more information about the sample programs, see 
Chapter 6, “Setting up the Sample Programs.” For more information about using 
exporting and loading data, see the Essbase Analytic Services Database 
Administrator’s Guide.
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Synchronizing Users and Security Across a Cluster
When you create a cluster of Essbase servers with Essbase Deployment Services, 
you must add users and their relevant access permissions to all Essbase servers in 
the cluster. If you have large numbers of users, this can be time consuming.

Essbase Deployment Services provides a command for loading Essbase users into 
its domain storage and settings for pushing those users to other Essbase servers in 
a cluster, but the information is incomplete. For more information see, “Loading 
Essbase Users into Essbase Deployment Services” on page 80.

Beyond the procedure mentioned above, consider creating users and access 
information on the master Essbase server using a MaxL or ESSCMD script and 
reuse this script on the other servers in the cluster. Finally, you may have to 
manually replicate some user and access information across the servers of your 
cluster. For more information about using MaxL and ESSCMD, see Technical 
Reference.

Loading Essbase Users into Essbase Deployment 
Services

Essbase Deployment Services provides a way to load users from a Essbase server 
and then push those user names and passwords onto other Essbase servers. The 
process requires that the Deployment Services server reset all the passwords on the 
Essbase server and the push process creates the users but does not replicate their 
privileges on the other Essbase servers.

➤ To load users into Essbase Deployment Services from a Essbase server:

1. Verify that the Essbase Deployment Services server and the Essbase server 
containing the users you want to load are running.

2. In the HYPERION_HOME\eds\bin directory, locate the startCmdShell file 
(.cmd on Windows systems, .sh on UNIX systems).

3. Run the startCmdShell file.

4. Log on to the Essbase Deployment Services server using the signon 
command; for example,

EDS>signon 
Enter input as user,passwd,domain,prefServer,plugin: 
system,password,essbase,localhost,http 
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5. Use the syncsectoees command to load the user name information into the 
Essbase Deployment Services server and reset the password to a default value 
on both servers; for example,

EDS>syncsectoees
Enter input as olapSvrName,domName,defPwd,syncPwd:
localhost,essbase,password,true

CAUTION: Performing this operation resets the passwords for all users on 
the Essbase server.

User names and passwords are now the same on the Essbase Deployment 
Services server and Essbase server with which you connected.

After loading the user names, you can configure the Essbase Deployment Services 
server to create user names on Essbase servers as it connects to them. The settings 
for this configuration are set in the essbase.properties file.

Essbase Deployment Services can create Essbase users and passwords, but can not 
set security access levels for those users. Create all needed user accounts directly 
on the Essbase servers and assign the required security access privileges . If 
necessary you can replicate the user list on additional Essbase servers. If a user 
changes a password through an Essbase Deployment Services client program, that 
password is loaded on to the Essbase servers as the user connects to each server.

CAUTION: The Deployment Services server creates the users and 
passwords on the Essbase servers but it does not replicate the access 
privileges of the users. 

You must manually create the privileges for the users on each of the Essbase 
servers. After these privileges have been assigned, the maintenance of the users 
and privileges must continue on the Essbase servers. Essbase Deployment 
Services does not synchronize the privileges of users across the Essbase servers.
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Fault Tolerance
There are two levels of fault tolerance in Essbase Deployment Services.

Fault Tolerance in the Java API
If Essbase Deployment Services stops (normally or abnormally) and is restarted 
while a Java API client session is already in progress, the Java API will 
automatically restore the session. This feature is currently not supported for 
outline operations and cube view operations, and is supported for all the rest of the 
functionality. 

Fault Tolerance in Essbase Deployment Services

Case 1
To get Essbase Deployment Services to reconnect and retry data query operations 
(read-only) on the same OLAP server, perform the following steps. 

Deployment Services needs to be configured with connection pooling (in 
connection per operation mode or connection per session mode) over a cluster or 
over a component (cube). 

The Java API client performing data query using openCubeView, make sure that 
the last four parameters are True.  

IEssDomain.openCubeView(String cubeViewName, 
                        String olapSvrName,
                        String appName, 
                        String cubeName,
                        boolean useConnPool,
                        boolean connPerOp,
                        boolean useCluster,
                        boolean readOnly)

In addition, make sure connection pool is configured for the specified appName 
and cubeName. 

The following Essbase error conditions can be recovered: 

● User logged out by Supervisor (1013095 ). 

● Essbase agent restarted (1042006 ). 

● Invalid login id (1013136). 
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● Logged out due to inactivity (1051021 ). 

● System is temporarily busy (1051010 ). 

● Client timed out to receive data via tcp (1042017). 

● Cannot receive data (1042013). 

Several external conditions can also be recovered. Many conditions can be 
identified in the Essbase.Properties file before the condition occurs. Specify 
the  following in the Essbase.Properties file before starting the Essbase 
Deployment Services server:  

system.faultTolerance.reconnectRetryOnSameSvcComp.onErrorCodes=
1013095,1042006,1013136,1051021,1051010,1042017,1042013

If you encounter error codes other than those specified in the condition above, add 
those to the comma-separated list in the above Essbase.Properties entry. 

Example usage scenario: 

1. Create a cluster (for example, demobasiccluster) with 2 identical components 
(localhost/demo/basic, localhost/demo2/basic) 

2. Create a connection pool (for example, demobasicpool) using this cluster 
(demobasiccluster), and set  initial connections as 4, maximum 
connections as 4, and connection increment as 0. 

3. Enable this cluster and connection pool to be hosted by the Essbase 
Deployment Services server. 

4. Start the OLAP servers and the Essbase Deployment Services server. 

5. Start the clients that use Java API data query operations over the connection 
pool. 

6. See that the requests are equally distributed between demo/basic and 
demo2/basic. 

7. Logout the connection pool user from the OLAP server using the Essbase 
Application Manager. 

8. Continue running clients using the Jave API data query operations. 

9. See that the Essbase Deployment Services server automatically reestablishes 
the connection on the same OLAP server, without interrupting the clients. 
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Case 2
To get Essbase Deployment Services to retry (without reconnecting) data query 
operations (read-only) on the same OLAP server, perform the following steps. 

1. Essbase Deployment Services needs to be configured with connection pooling 
(in connection per operation mode or connection per session mode) over a 
cluster or over a component (cube). 

2. Specify the following in the Essbase.Properties file, along with proper 
error codes separated by comma, before starting the EDS server:  

system.faultTolerance.retryOnSameSvcComp.onErrorCodes= 

Case 3
To get Essbase Deployment Services to retry data query operations (read-only) on 
different OLAP server in the cluster, perform the following steps. 

Essbase Deployment Services needs to be configured with connection pool (in 
connection per operation mode) over a cluster. In addition, make sure connection 
pool over cluster is configured with at least one component matching the specified 
appName and cubeName. 

The Java API client performing a data query using openCubeView needs to make 
sure that the last four paramenters are True. 

IEssDomain.openCubeView(String cubeViewName, 
                        String olapSvrName, 
                        String appName, 
                        String cubeName, 
                        boolean useConnPool, 
                        boolean connPerOp, 
                        boolean useCluster, 
                        boolean readOnly) 

The following error conditions can be recovered :

● Disabled user commands (1013009, 1013204, 1054009, 1054010) 

● Active database stopped by supervisor (1013110) 
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Several external conditions can also be recovered. Many conditions can be 
identified in the Essbase.Properties file before the condition occurs.  Specify 
the  following in the Essbase.Properties file before starting the Essbase 
Deployment Services server:  

system.faultTolerance.retryOnNextSvcComp.onErrorCodes= 
1013009,1013204,1054009,1054010,1013110 

If you encounter error codes other than those specified in the condition above, add 
those to the comma-separated list in the Essbase.Properties entry.

Example usage scenario: 

1. Create a cluster (for example, demobasiccluster) with 2 identical 
components (localhost/demo/basic, localhost/demo2/basic) 

2. Create a connection pool (for example, demobasicpool) using this cluster 
(demobasiccluster), and set initial connections as 4, maximum 
connections as 4, and connection increment as 0. 

3. Enable this cluster and connection pool to be hosted by the Essbase 
Deployment Services server. 

4. Start the OLAP servers and the Essbase Deployment Services server. 

5. Start the clients that use the Java API data query operations over the 
connection pool. 

6. See that the requests are equally distributed between demo/basic and 
demo2/basic. 

7. Disable commands on demo application using the Essbase Application 
Manager or the Essbase Deployment Services Console. The reason to disable 
commands on an application is to perform operations such as data load. 

8. See that the requests now only go to localhost/demo2/basic, as Essbase 
Deployment Services detects the error and re-routes the request to the next 
component in the cluster (localhost/demo2/basic) 

9. Enable commands on demo application. 

10. See that the requests are equally distributed between demo/basic and 
demo2/basic. 
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6

Chapter

6
Setting up the Sample 
Programs

Essbase Deployment Services includes a set of sample Java programs for testing 
the product and to use as a reference when developing custom client programs. 
This chapter discusses the sample programs, how to set up your computer 
environment to work with them, and how to compile and run them.

This chapter contains the following topics:

● “Understanding the Sample Programs” on page 87

● “Configuring Analytic Servers” on page 90s

● “Configuring Essbase Deployment Services Servers” on page 91

● “Compiling and Running the Sample Programs” on page 92

● “Next Steps” on page 95

Understanding the Sample Programs
The sample programs provided with Essbase Deployment Services help you test 
the software and get you started on developing client programs for Essbase 
Deployment Services. In order to run the sample programs, you must configure 
your environment with the following components:

● An Essbase Deployment Services server

● A supported Essbase server with users and sample applications

For information about setting up Essbase Deployment Services for the sample 
programs, see “Configuring Essbase Deployment Services Servers” on page 91. 
For information about setting up Essbase for the sample programs, see 
“Configuring Analytic Servers” on page 90.



88 ■

Setting up the Sample Programs

Essbase Deployment Services Installation Guide

Unless otherwise noted in this document, the sample programs assume that all 
necessary software components (Essbase Deployment Services, Essbase, and the 
sample programs themselves) are running on the same computer.

The sample programs demonstrate areas of functionality provided through 
the Essbase JAPI. The sample programs are located in the 
HYPERION_HOMEeds\samples directory. The areas covered by each 
sample program are summarized in the following list:

● BuildDimension.java, adds and removes members from the outline in the 
active database. 

● CdfCdm.java, shows the usage of CDF and CDM.

● CellAttributes.java, signs on to essbase domain, opens a cube view, 
performs a retrieval, gets the cell attributes, and signs off. 

● ClientCache.java, demonstrates the setting and use of client-side caching 
with the Essbase JAPI.

● Connect.java, demonstrates a simple connection and disconnection from a 
Essbase Deployment Services server.

● ConnectUsingHttpUrl.java, signs on to a domain using HTTP and signs 
off.

● ConnPoolDataSource.java, demonstrates using connection pool for data 
source operations.

● CopyOlapAppAndCube.java, copies an Essbase application and cube from 
one server to another.

● CreateConnPoolAndCluster.java, creates a cluster and a connection 
pool.

● CreateOlapApp.java, creates olap applications. 

● CreateOutline.java, creates a cube outline, creates dimensions, members 
and other outline elements, verifies the outline and restructures the database.

● DataQuery.java, demonstrates basic retrieval of data from a Essbase 
database.

● DataSource.java, demonstrates the retrieval of Essbase server information 
and execution of reports.

● Domain.java, demonstrates management of Essbase Deployment Services 
domains, including adding and removing of users, groups, domains, Essbase 
servers, and Essbase Deployment Services servers.
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● EmailDataQueryOutput.java, signs on to an essbase domain, opens a 
cube view, performs a retrieval, Emails the output to a recipient and signs off.

● GetMembers.java, signs on to essbase domain, performs various metadata 
operations and signs off.

● GridDataUpdate.java, demonstrates the retrieving and updating of data in 
a grid format. 

● GridLockUnlock.java, signs on to an essbase domain, opens a cube view, 
performs a lock, retrieval, unlock and signs off.

● GridWithUnknownMembers.java demonstrates how to detect unknown 
members in data query. 

● HisDrillThrough.java, signs on to an essbase domain, opens a cube view, 
performs HIS drill-through, lists reports, executes reports, and signs off.

● HisDrillThroughOnRange.java, signs on to an essbase domain, opens a 
cube view, performs HIS drill-through, lists reports, executes reports, and 
signs off.

● HybridAnalysis.java, demonstrates how to use the Hybrid Analysis 
option for data query and meta data operations.

● HyperionCss.java, demonstrates how to use Hyperion Security Platform.

● KillRequest.java,  demonstrates how to kill long-running olap requests.

● LinkedObjects.java, signs on to an essbase domain, opens a cube view, 
performs a retrieval, performs LRO operations, and signs off.

● LinkedPartition.java, signs on to an essbase domain, opens a cube view, 
performs a retrieval, looks for a linked partition in a cell, and signs off.

● ListAndKillOlapRequests.java, signs on to an essbase domain, 
connects to an analytic server, lists the requests, kills requests, and signs off.

● LoadData.java, loads data to a cube.

● LocateServers.java, locates the running Deployment servers.

● MdxQuery.java, signs on to an essbase domain, opens a cube view, performs 
a retrieval, a zoom in, a zoom out, a keep only, a remove only, a pivot, and 
signs off. 

● MemberSelectionOverOutlineCache.java,  performs member 
selection over outline cache maintained in a Deployment server.
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● MetaData.java, demonstrates retrieval of metadata information from a 
Essbase database, including member selection.

● OlapServerConnect.java, signs on to an Analytic server and signs off. 

● PropertyViewer.java, gets an application/database object, enumerates its 
properties and prints the values.

● ReadOutline.java, signs on to an essbase domain, reads various items in 
an outline and signs off.

● RunReport.java, demonstrates the running of a report from a Essbase 
database.

● SyncCubeReplicas.java, demonstrates the replication of data between 
two Essbase databases.

● UserCustomPreference.java, demonstrates the setting of a custom 
preference for a user on a Essbase Deployment Services server.

● ViewOutlineTree.java, demonstrates the listing of all outline members 
from Essbase database outline.

The sample programs can use an Essbase Deployment Services server that uses a 
supported configuration. For more information about creating client programs that 
work with Essbase Deployment Services servers, see the online Essbase 
Deployment Services JAPI Reference in the Essbase Deployment Services DOCS 
directory.

Configuring Analytic Servers
The sample programs require a Essbase Analytic Server Release 7.0 or later server 
with the Demo Basic sample application loaded. You must also create the users 
system and guest on the Analytic server.

If you plan to use several Analytic servers in a cluster with the sample programs, 
you must perform the following procedure for all Analytic servers in the cluster.
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➤ To configure Analytic servers for use with the sample programs:

1. On the Analytic server, verify that the sample applications Demo Basic and 
Sample Basic are installed and that the databases have been loaded with data. 
For information about installing the sample applications in Essbase, see the 
Essbase Analytic Services Installation Guide.

2. If you are going to use the SyncCubeReplicas sample program, make a copy 
of the Demo application and name it Demo2. For information about copying 
Essbase applications, see the Essbase Analytic Services Database 
Administrator’s Guide.

3. On the Essbase server, create the following users: 

● system, a user with supervisor rights and a password of password

● guest, a normal user with read access to the Demo application (and the 
Demo2 application, if created) and a password of password

For information on creating users in Essbase, see the Essbase Analytic 
Services Database Administrator’s Guide.

4. After completing these steps, keep the Essbase server running. 

You do not have to keep the Essbase Demo and Demo2 applications running. 
Essbase Deployment Services starts these applications automatically when 
they are required.

Configuring Essbase Deployment Services 
Servers

In order to use the sample programs, you must configure and run an instance of the 
Essbase Deployment Services server that uses one of the supported configurations. 
For information on configuring an instance of the server, see “Configuring Servers 
to Use TCP/IP, HTTP, or EJB” on page 52.

Once you have configured an instance of the server, you must perform additional 
configuration so you can use it with the sample programs.
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➤ To configure a Essbase Deployment Services server for use with the sample 
programs:

1. In the HYPERION_HOME\eds\bin directory, locate the 
essbase.properties file and open it in a text editor.

2. In the essbase.properties file, find the line that starts with 
olap.server.autoStart= and set this parameter to true; for example,

olap.server.autoStart=true 

This setting enables the Essbase Deployment Services server to start 
applications automatically on connected Essbase servers.

3. Save your changes and close the essbase.properties file.

After you have set this parameter, you must stop and restart the Essbase 
Deployment Services server. For information on starting servers see, “Starting and 
Stopping Essbase Deployment Services Servers” on page 46.

Compiling and Running the Sample Programs
After you have configured the required servers, you can then compile and run the 
sample programs.

The script file runsamples is provided for compiling the sample programs. This 
script must be configured to work with your computer environment. Once you 
have this script working in your environment, you can use it as a template for 
creating compile and run scripts for the other sample programs. 

Configuring the runsamples Script File
To configure the runsamples script file to work in your computer environment, you 
must verify that the path and other environment variables in the script are set 
correctly.

➤ To configure the runsamples file to work with your computer environment:

1. In the HYPERION_HOME\eds\samples directory, locate the runsamples 
script (.cmd on Windows systems, .sh on UNIX systems).

2. Open the runsamples script in a text editor.
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3. Verify that the HYPERION_HOME\eds variable is set to the location of your 
Essbase Deployment Services installation; for example,

set HYPERION_HOME\eds=C:\hyperion\eds\ 

4. Verify that the JAVA_HOME variable points to a supported version of the Java 
Runtime Environment. If you did not install the Java Runtime Environment 
with Essbase Deployment Services, you must update this variable with a full 
path to the Java installation; for example,

set JAVA_HOME="C:\Program Files\JavaSoft\JRE\1.3\" 

5. Replace the variable values for USER, PASSWORD, DOMAIN, 
EDS_SERVER, and OLAP_SERVER, as necessary. These variables are set 
at the beginning of the runsamples file.

Tip: To make running the example programs easier, set up Essbase Deployment 
Services and Essbase on your local computer. Then, in Essbase, create a user 
system with a password of password and full access to the Sample Basic, Demo 
Basic, and Demo2 Basic databases. If you set up your computer system in this 
configuration, you do not need to modify the default settings for the sample client 
programs.

6. Save the runsamples script file.

Running the runsamples Script
After you have configured the runsamples script to work with your environment, 
you are ready to run the script, which compiles the sample programs and runs one 
of them.

➤ To run the runsamples script:

1. Verify that the Essbase Deployment Services server and Essbase server are 
running.

2. In the HYPERION_HOME\eds\samples directory, locate the runsamples 
script (.cmd on Windows systems, .sh on UNIX systems).
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3. Run the script by typing the following command at the command prompt:

>runsamples http 

This example runs the sample program for a Essbase Deployment Services 
server that uses HTTP. For other server types, replace HTTP with the server 
type you are using.

4. Follow the on-screen prompts to compile and run the sample programs.

Creating Compile and Run Scripts
The runsamples script compiles all the sample programs but runs only one of them. 
To run the other sample programs, you must create your own scripts or modify the 
runsamples script.

You can use the runsamples script as a template for new scripts. The following 
procedure shows you how to create a version of the runsamples script to run a 
different sample program.

➤ To create a version of the runsamples script to run another sample program:

1. In the HYPERION_HOME\eds\samples directory, locate the runsamples 
script (.cmd on Windows systems, .sh on UNIX systems).

2. Open the runsamples script in a text editor.

3. In the script file, find the line that begins with echo Step-2 and modify the 
two lines as shown below:

echo Step-2: Ready to run MetaData example ...
pause
%JAVA_HOME%\bin\java %VBROKER_PROPS%
com.hyperion.essbase.samples.MetaData %USER% %PASSWORD%
%DOMAIN% %EDS_SERVER% %ORB% %PORT% %OLAP_SERVER%

To use the script to run another sample program, substitute the name of the 
sample program class for MetaData, as shown in the preceding sample.

4. Configure this script to work in your computer environment by performing the 
procedure described in “Configuring the runsamples Script File” on page 92.

5. Save the script file in the HYPERION_HOME\eds\samples directory. Save 
the file with an extension .cmd on Windows systems or a.sh extension on 
UNIX systems.
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Running Compile and Run Scripts
After you have created compile and run scripts for the other sample programs and 
configured them to work with your computer environment, you are ready to run 
these scripts.

➤ To run the compile and run scripts:

1. Verify that the Essbase Deployment Services server and Essbase server are 
running.

2. In the HYPERION_HOME\eds\samples directory, locate the script file (.cmd 
on Windows systems, .sh on UNIX systems).

3. Run the script by double-clicking the file or by typing the name of the script 
command at the command prompt.

4. Follow the on-screen prompts to compile the sample program and run it.

Next Steps
After you have successfully compiled and run the sample programs, you are ready 
to create your own client programs for Essbase Deployment Services. 

For more information about the available classes and methods in the Essbase JAPI, 
see the online Essbase Deployment Services JAPI Reference in the Essbase 
Deployment Services DOCS directory.
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accounts. A list of users and groups that determine access to a domain in Essbase 
Deployment Services.

Application Programming Interface (API). A library of functions that you can 
use in a custom program. Essbase Deployment Services provides a Java API that 
you can use to develop client programs.

applet. In Java, a program that can run in a Web browser. Small programs written 
in languages other than Java are sometimes referred to as applets.

application server. A Java software server that runs Enterprise Java Bean (EJB) 
programs, Java servlets, Java Server Pages (JSPs) and provides infrastructure for 
large-scale Java programs, such as connection pooling, session pooling, 
multithreading and load balancing.

cluster. A group of Essbase Deployment Services or Essbase servers to act as a 
single server to share task loads and provide failover support. Clustering 
eliminates Essbase servers as a single point of failure in a system.

connection pooling. A collection of user logins to Essbase servers. Pooling of 
user connections facilitates the scaling of Essbase applications to thousands of 
users.

Common Object Request Broker Architecture (CORBA). A distributed 
software-to-software communication specification which enables remote 
procedure calls from one software program to another on the same computer or 
across a network.

cube. A representation of an Essbase multidimensional database.

domain. A logical grouping of administrative objects, such as users, groups, and 
servers.

Enterprise JavaBean (EJB). Server side framework and programming 
architecture for creating distributed java applications.
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Deployment Services server. A server running the Essbase Deployment 
Services software that manages requests between the client and OLAP servers, in 
addition to providing various services, such as event handling and authentication.

Essbase JAPI. Object-oriented application programming interface, enabling 
programmers to create custom Java applications for Essbase and Essbase 
Deployment Services. 

failover support. Automatic detection of service interruption due to Essbase 
server failure. When failure occurs, Essbase Deployment Services dynamically 
routes server requests to the next Essbase database in the cluster.

group. A list of Essbase users. A user can belong to more than one group.

Hypertext Transfer Protocol (HTTP). A widely supported communication 
protocol used by Web browsers, Web servers, and other software programs to 
communicate over the Internet.

Internet Inter-ORB Protocol (IIOP). The communication protocol used to 
communicate between CORBA ORBs over TCP/IP.

JAPI. Java Application Programming Interface.

J2EE (Java 2, Enterprise Edition). A specification for Java technology, 
including the Java programming language, Java application servers and related 
technology.

load balancing. Distribution of requests across a group of Essbase servers, which 
ensures optimal end user performance.

OLAP server. A server running multidimensional databases, such as Essbase.

Object Request Broker (ORB). Technology that enables clients to 
communicate with servers via an object bus.

RAID (redundant array of independent [or inexpensive] disks). A persistent 
storage system that provides convenient, low-cost, and highly reliable storage by 
saving data on more than one disk simultaneously. 

Relational Database Management Systems (RDBMS). A type of database 
management system that stores data in the form of related tables.

Remote Method Invocation (RMI). A programmatic remote access 
communication protocol for communication between Java programs. This 
protocol is typically used in communication between EJBs running on application 
servers.
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replication. In Essbase Deployment Services, the copying of data from one 
Essbase application database to another.

single sign-on. Ability to log into an Essbase Deployment Services domain only 
once and, based on access rights, access resources.

Service Provider Interface (SPI). A technology enabling new services to be 
added to Essbase Deployment Services.

Servlet. An small application (applet) that runs on the server rather than the client 
in a client/server system.
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E
education services, xi
EES as a UNIXprocess, 41
EJB, 20
Essbase, 77 to 78
Essbase and EDS, 13
Essbase Integration Server, 79
Essbase servers, 54
Essbase system architecture, 14
Essbase.Properties file, 46
export, 79
External Authentication, 78

F
failover support, 15, 82
fault tolerance, 15, 82
features, EDS, 14
flat file, 52
flat file domain storage, 52

H
HTTP, 19
HTTP mode, 75
Hyperion Consulting Services, xi
Hyperion Education Services, xi
Hyperion Technical Support, xi
hyperion_home variable, 32, 40

I
installed files, 31

J
Java, 15, 28, 88
Java API, 16, 88
Java programs, 87

L
load, 79 to 80
load balancing, 14

M
managing clusters, 77
Migrating, 45
Migration, 45

N
network protocols, 28
New Releases, 45

O
online guide

accessing, ix
displaying, ix
searching, ix

online help
accessing, ix
accessing on UNIX systems, 43
printing, ix

Outline Caching, 77
overview, EDS, 13

P
partitions, 79
physical memory

Solaris system requirements, 36
pointer, to properties file, 46
Preserving Existing Installations, 45
properties file, 46
protocols, 16, 18 to 20

configuring, 53

R
RDBMS domain storage, 50
remote activation, 55
replicating databases, 78
requirements on Windows systems, 28
resource allocation, 21, 24
retrieval, 25
runsamples script, 92
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S
sample programs, 87 to 88
samples, 92
script file, 92
security, 80
Security Authentication, 78
server

configuring for samples, 91
server clustering, 14
Server Clusters, 57
server management, 73
server, EDS, 16
setting ARBORPATH on UNIX, 60
setting ARBORPATH on Windows, 60
setting up sample programs, 87
shell, 47
startees script, 47
startgui file, 43
starting EDS command shell, 76
starting EDS console, 75
starting EDS servers, 74
stopping EDS command shell, 76
stopping EDS console, 75
stopping EDS servers, 74
storage, 25
Sun ONE, 71

supported protocols, 28
synchronizing, 79
synchronizing databases, 78
synchronizing users, 80
system administration, 73

T
TCP/IP, 18
TCP/IP, configuring, 53
technical support, xi
Temporary directory, 78
Tomcat, 67

U
uninstalling, 48
Uninstalling on UNIX, 41
usage limits, 23

W
WebLogic, 67, 69
WebSphere, 70
Windows, 28
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